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CHAPTER
ONE

INTRODUCTION

mvme is a VME data acquisition solution by mesytec aimed at nuclear physics experiments involving a single
VME controller. The goal of this project is to provide an easy to setup, easy to use, cross-platform data acquisition
system with basic data visualization and analysis capabilities.

VME | mvme
| VME Config
FPGA based : Madule Module
VME controller Init Scripts Readout Scripts
: ]
M Interactive Commands < Setup itl] jJjil
IL Scripts Scripts
1l _ \
ro'f.
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‘~§ Trigger Stack 1 q r\' .
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Bus |
[Compression] -
— Module O |
Replay
— Maodule 1 |

1.1 Features

Fig. 1.1: mvme overview

* High-rate, low-latency VME module readout

* Supports the following VME Controllers:

— Mesytec MVLC

% USB3, USB2 and Ethernet connectivity

+ Lowest-latency readout, lowest deadtime
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# Flexible Trigger and I/O logic module
+ Possibility to use optical fiber based Ethernet via onboard SFP cage
+ GBit/s Ethernet connection required if using Ethernet!
— WIENER VM-USB (USB2, readout rates of up to 15 MB/s)
— Struck SIS3153 (Ethernet)
* Readout rates of up to 35 MB/s from a single module.
+ Optimized setups can yield around 52 MB/s.
* GBit/s Ethernet connection required!

* Easy creation and configuration of the VME setup

Multiple event triggers are possible (NIM, IRQ, periodic readout)

Multiple modules can be read out per trigger

Flexible VME module setup using configuration scripts

Not limited to mesytec VME modules
* Live histogramming of readout data (1D and 2D)

» Rate Monitoring of internal system rates and external rates generated from readout data (e.g. scaler modules,
event counters).

* Flexible VME module data extraction using matching and filtering on the bit level
* Graphical analysis Ul
» Optional compression of output listfiles
* Replays of recorded listfile data
* JSON-RPC remote control interface over TCP
Allows to remotely start and stop DAQ runs and request status information.
» Export of readout data to ROOT object trees.

* The analysis side is detached from the readout side. This means analysis complexity does not have a negative
effect on readout performance. Instead during a live DAQ run the analysis side will only get as much data
as it can process.

1.2 High-level overview

1.2.1 The VME side

mvme achieves high data rate, low-latency VME readout by using the VME controllers autonomous DAQ mode.
In this mode the controller executes lists of commands (trigger stacks) upon activation of a specific trigger
condition. Data generated by the execution of trigger stacks is buffered and then sent over USB or Ethernet to the
controlling computer.

In mvme the physical VME setup is described as a tree of objects with events as top-level nodes. Each event has
a trigger condition (e.g. Interrupt or NIM) and contains the modules to be read out on every activation of the
trigger.

A module in mvme has a collection of VME Scripts. These scripts contain the module configuration (module
specific parameters, multicast setup, etc.) and the commands required to perform the readout. The readout com-
mands of all modules belonging to the same event are combined to form the trigger stacks uploaded to the VME
controller.
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Object Info
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Fig. 1.2: VME setup with one event containing two modules

The VME setup also describes the structure of the data that is expected to be read out and thus allows the software
to validate the received data stream.

For mesytec modules fully commented initialization files are bundled with mvme and can be loaded as templates.

1.2.2 Analysis

mvme contains an analysis system that allows parameter extraction (e.g. ADC values per channel), calibration,
accumulation and visualization of data both during a DAQ run and while replaying from file. Additionally a set
of built-in operators can be used to perform calculations and transformations on the data as it flows through the
system.
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LD Parameter Extraction L1 Processing =
¥ [ mdppls
» 7 mdppl6.amplitude p % Cal mdppl6.event_counterts
P | mdppl6.event counter/ts b U Cal mdppl6.time
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Fig. 1.3: Analysis UI with MDPP-16 default objects

The structure defined by the VME configuration is also present in the analysis: modules which are read out as a
result of the same trigger condition are grouped together in an event.

The system itself models dataflow from sources, through operators, into sinks. Data is transported in the form of
parameter arrays with each element carrying the parameters numeric value and additional meta information.

Evert _ _ _ __ raw rmodule data parameter array

Module 0 -E—/) Source _/) - \

Module 1 i—) Source — - — -
Ty ' '

Sink Sink Sink

Fig. 1.4: Example analysis dataflow

Sources are data extractors that are directly attached to a VME module. A source receives each data word that
was read out from the module in response to a trigger condition. Sources are used to split the data into logical
parts, e.g Amplitude and Time data and to extract the corresponding raw values.

Operators are logic pieces used to perform calculations on the data (e.g. calibrate raw ADC values to voltage).
Operators can have multiple inputs and produce a single output array.

Sinks are data accumulators that do not produce any output parameters. Currently 1D and 2D histograms, a rate
monitor and a file exporter are implemented.

Output parameters of sources and operators can be inspected at runtime. Objects can be added, removed and
modified even while the DAQ or a replay is running. Changes are effective immediately.

mesytec GmbH & Co. KG 4/75
Wernher-von-Braun-Str.1, D-85640 Putzbrunn, Germany
phone: +49 - 89 / 456007-30 fax: +49 - 89 / 456007-39
info@mesytec.com - www.mesytec.com



mesytec

WWW. .com

mvme - mesytec VME Data Acquisition

1.2.3 The DAQ process

When requested to start a data acquisition run mvme performs the following steps:
* Initialize the VME controller using information from the VME configuration
* Setup modules using the module VME scripts
¢ Switch the controller into autonomous DAQ mode
* Repeat until DAQ is stopped:
— Read a data buffer from the VME controller

Validate the structure of the received data

Augment the data with mvme specific meta data

Write data to the listfile (optionally using compression)

Pass data to the Analysis
¢ Tell the controller to leave DAQ mode

¢ Close the listfile

Note: Data acquisition and writing the data to file have the highest priority in mvme. If during a DAQ run the
analysis system cannot keep up with the incoming data rate some buffers will not be passed on to the analysis.

The fraction of processed buffers / total buffers is called the analysis efficiency and is shown in the bottom status
bar of the analysis window. Hovering of the Efficiency number shows a tooltip with detailed buffer counts.

When replaying from file all buffers are passed to the analysis.
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CHAPTER
TWO

INSTALLATION

2.1 System Requirements

¢ A recent 64-bit Linux distribution or a 64-bit version of Windows 7 or later.
* One of the supported VME Controllers:

— mesytec MVLC (USB3/2, GBit/s Ethernet)

— WIENER VM-USB (USB2)

— Struck SIS3153 (GBit/s Ethernet)

 Firmware updates for the MVLC can be found here: https://mesytec.com/downloads/firmware%20updates/
MVLC/

* If using the WIENER VM-USB VME Controller:
— WIENER VM-USB VME Controller with a recent firmware

The VM-USB firmware can be updated from within mvme. See VM-USB Firmware Update for a
guide.

— Latest USB chipset driver for your system.

Updating the driver is especially important for Windows versions prior to Windows 10 in combination
with a NEC/Renesas chipset (frequently found in laptops). The driver shipped by Microsoft has a bug
that prevents libusb from properly accessing devices. See the libusb wiki for more information.

— USB Diriver: libusb-0.1 (Linux) / libusb-win32 (Windows)
The windows installer can optionally run Zadig to handle the driver installation.
* Atleast 4 GB RAM is recommended.

* A multicore processor is recommended as mvme itself can make use of multiple cores: readout, data com-
pression, analysis and the user interface all run in separate threads.

2.2 Installation Steps

2.2.1 Linux

The mvme archives for Linux include all required libraries. The only external dependency is the GNU C Library
glibc. When using a modern Linux distribution no glibc versioning errors should occur.

To install mvme unpack the archive and execute the mvme startup script:

$ tar xf mvme-x64-1.0.tar.bz2
$ ./mvme-x64-1.0/mvme.sh
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2.2.1.1 MVLC_USB and VM-USB Device Permissions
To be able to use the MVLC_USB or the VM-USB VME Controllers as a non-root user a udev rule to adjust the
device permissions needs to be added to the system.

For the MVLC a udev rules file is contained in the installation directory under extras/mvlc/51-ftd3xx.
rules. Copy this file to your udev rules directory (usually /etc/udev/rules.d/).

The rules file for the VMUSB can be found under extras/vm-usb/999-wiener-vm_usb.rules.

After copying the file reload udev using service udev reload or /etc/init.d/udev reload or
service systemd-udev reload depending on your distribution or simply reboot the machine. The con-
troller also has to be reconnected to your PC for the device permissions to update.

2.2.2 Windows

Run the supplied installer and follow the on screen instructions to install mvme.

2.2.2.1 VM-USB only: Driver Installation

To be able to use the VM-USB VME Controller the libusb-win32 driver needs to be installed and registered with
the device. An easy way to install the driver is to use the Zadig USB Driver Installer which comes bundled with
mvme. You can run Zadig at the end of the installation process or at a later time from the mvme installation
directory.

In the Zadig UI the VM-USB will appear as VM-USB VME CRATE CONTROLLER. If it does not show up there’s
either a hardware issue or another driver is already registered to handle the VM-USB. Use Options -> List All
Devices to get a list of all USB devices and look for the controller again.

Device Options Help

['I.I'M-USB VME CRATE CONTROLLER 7 ] [T Edit

Driver  libushD (v1.2.6.0) ) lbusb-win32 (v1.2.6.0) : More Information
WinlJSE (libush

USBID 16DC  000B libush-win32

) Reinstall Driver libusbi
we & K WinUSB (Microsoft

& devices found.

Fig. 2.1: Zadig with VM-USB and libusb-win32 selected

Make sure libusb-win32 is selected as the driver to install, then click on Install Driver. Zadig will generate a
self-signed certificate for the driver and start the installation process.

It is highly recommended to restart your system after driver installation, especially if you replaced an existing
driver. Otherwise USB transfer errors can occur during VME data acquisition!

In case you want to manually install the driver a ZIP archive can be found here: libusb-win32.
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2.2.3 Installation from source

The mvme sources are available on github: https://github.com/flueke/mvme

Refer to the README file for a list of required dependencies and build instructions for Linux, Windows and Mac
OS X.

2.3 Ethernet DHCP/ARP setup

When using the MVLC via Ethernet or the SIS3153 controller some network setup has to be done.

The easiest way to get a working setup is if you are running a DHCP server on your network. Both of the
controllers will request an IPv4-Address and a hostname via DHCP after powerup.

The MVLC will request the hostname mv1c—-NNNN where NNNN is the serial number shown on the front-panel
near the Ethernet port.

The SIS3153 requests a hostname of the form sis3153-0DDD where DDD is the decimal serial number as printed
on the board.

After the DHCP phase the two controllers should be reachable via their hostnames. You can verify this by opening
a command prompt and running

ping mvlc-0010
for the MVLC with serial number 10.

2.3.1 Using a manual ARP entry
In case DHCP with hostname assignment should not or cannot be used an alternative approach is to manually
associate the MAC-address of the controller with an IP-address.

* Obtaining the controllers MAC-address

The first step is to figure out the controllers MAC-address. This is the serial-number dependent Ethernet
address of the controller.

For the MVLC the MAC-address is 04 : 85: 46 :d2 : NN : NN where the NN : NN is the serial number of the
MVLC in decimal. So for MVLC-0015 the full MAC-address is 04:85:46:d2:00:15.

The MAC-address of the SIS3153 is 00:00:56:15:3x:xx where x:xx is the serial number in hex-
adecimal. So for my development controller with S/N 42 the serial becomes 0x2a and the resulting MAC-
address is 00:00:56:15:30:2a.

With the MAC-address at hand we can now create an IPv4-address to MAC-address mapping in the operating
systems ARP table.

This step is specific to the operating system and will require root/admin permissions. The below examples asso-
ciate the IP-address 192.168.100.42 with the controllers MAC-address. You have to change the IP-address
to match your local network setup, otherwise the operating system does not know how to reach the controller.

* Creating the ARP entry under linux:
With root permissions an ARP entry can be addded this way:
arp -s 192.168.100.42 04:85:46:d2:00:15

To make the entry permanent (at least on debian and ubuntu systems) the file /etc/ethers can be used. Add a
line like this to the file:

04:85:46:d2:00:15 192.168.100.42

This will take effect on the next reboot (or when restarting the networking services I think).
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* Creating the ARP entry under windows:

Open a cmd . exe prompt with administrator permissions and use the following command to create the
ARP entry:

arp -s 192.168.100.42 04-85-46-d2-00-15
To verify that the connection is working you can try to ping the controller:
ping 192.168.100.42

If everything is setup correctly the controller should answer the ping requests.
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CHAPTER
THREE

QUICKSTART GUIDE

The quickstart guide explains how to create a simple setup using the mesytec MVLC VME controller and one
mesytec VME module. The modules internal pulser is used to generate test data. Data readout is triggered by the
module itself using IRQ1 on the VME bus.

Note: In this example an MDPP-16 with the SCP firmware is used but any mesytec VME module should work.
For other modules the value written to the pulser register (0x6070) might need to be adjusted. Refer to the modules
manual and the VME templates for details.

 Start mvme and create a new workspace directory using the file dialog that should open up. This directory
will hold all configuration files, recorded listfiles, exported plots, etc.

* Three windows will open:
— A main window containing DAQ controls, the VME configuration tree and a statistics area.
— The analysis window. As there are no VME events and modules defined yet the window will be empty.

— A log view where runtime messages will appear.
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M doku-workspace - [DAQ mode]

File Window Tools Help

Start 1 Cycle
Histo data: Keep (® Clear
VME Controller: Connected (MVLC_USB)|  Settings

Reconnect

DAQ State: Idle
Analysis State: Idle

SDAQ.Control.

Run Settings | Workspace Settings

Current Filename:

Current Size:
Free Space:

0.00B
156.01 GB

e | ' & | &

New B, As re, | -
~MME Config
Object

= MVLC Trigger/1O

[ DAQ Start
v I Events

v event0

¥ [ Modules Init

v = mdppl6

Module Reset
Module Init
Frontend Settings
VME Interface Settings

» ] Readout Loop
Running time: 00:00:00
Buffers read: 0
Buffer Errors: 0
Data rates:
Avg. read size: 0
Bytes read: 0.00 MB

MVLC USB Frame Type Errors: 0, 0 errors/s
MVLC Stack Errors:

Info

Trigger=IRQ1

Type=MDPP-1...

0.00 buffersfs, 0.00 MB/s

-

M analysis.analysis - [Analysis UI]
L] 5 (S k]
e d 14 (3] ] 3 >
New Open Save SaveAs Clear Histos Infior & Stats Pause Load Session
o
Event: | eventd N i = = | s
Level Visiblity — Event settings Import

LO Parameter Extraction L1 Processing

* f= mdppl6 « [ Cal mdpplé
b 7 amplitude % €al amplitude
» T time »
» 7 timestamp »
» 7 trigger_time » il Cal trigger_time

Analysis

LO Raw Data Display L1 Data Display

* f= mdppl6 [ Cal Histos mdppl6
» o, H1D amplitude_raw b g H1D amplitude
b gl H1D time_raw b o H1Dtime
b g, H1D timestamp_raw b g H1D timestamp
» . H1D trigger_time_raw » [l H1D trigger_time

Efficiency: 0.00 Timeticks: 0 s Histo Storage: 35.00 MiB al::

17:53:21: Loaded Analysis: 4 Data Sources, 12 Operators from
analysis.analysis

17:53:24: Opened VME Controller MVLC_USE (speed=USB3, serial=89190087)

Log View

Log View

Fig. 3.1: GUI overview

Press the Settings button in the DAQ Control area and select the correct controller type (MVLC_USB in this
example). Assuming the controller is connected and powered on mvme will automatically find and use it. Also a
message containing information about the controller will appear in the Log View.

3.1 VME Setup

¢ Select the mvme main window (Ctrl+1) containing the VME Config area.

¢ Create a VME event:

— Right-click the Events entry in the VME tree and select Add Event.

— Select Interrupt in the Condition combobox. Keep the default of IRQ Level = 1.
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M Add Event

Mame eventl

Condition | Interrupt -
IRQ Level 1 -

Use Interrupt Acknowledge (IRQUselACK)
Note: enabling the IRQUselACK option will make IRQ handling slower but some VME modules might
require it to work properly.

VME Script Variables

Variable Name Variable Value Comment

sys. irg 1 IRQ value set for the VME Controller for this event.
EndOfEvent marker for mesytec modules (0: eventcounter,

mesy_eoe_marker 1 1: timestamp, 3: extended timestamp).

The most significant byte of the 32-bit multicast address
mesy_mest bb -

to be used by this event.
mesy_readout_num_events 1 Mumber of events to read out in each cycle.

=+ Add new variable| =

& cancel & oK

Fig. 3.2: Event Config Dialog

* Create a VME module:
— Right-click the newly created event (called “event0” by default) and select Add Module.

— Select MDPP-16_SCP from the module type list. If you changed the modules address encoders adjust
the Address value accordingly (the address encoders modify the 4 most significant hex digits).
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v Add Module o B 23

Type  |MDPP-16_SCP v |

MName |mdpplﬁ_5cp |

Address |09x00000000 |

WME Script Variables

Variable Name “Variable Value Comment

|+ Add new variable | =

|°§ancel |[ & ok ]

Fig. 3.3: Module Config Dialog

The VME Config should now look like similar to VME Config tree.

Object Info
= MVLC Trigger/lO
[ DAQ Start
b @ Events
“- event0 Trigger=IRQ1
* [ Modules Init
* s mdppl6_scp Type=MDPP-16_SCP, Address=...
= Module Reset
= Module Init
= Frontend Settings
=/ VME Interface Settings
¢ [ Readout Loop
b ] Multicast DAQ Start/Stop
| DAQ Stop
[ Manual

Fig. 3.4: VME Config tree

* Double-click the Module Init entry to open a VME Script Editor window. Scroll to the bottom of the editor
window or use the search bar to search for pulser and adjust the register value for the modules internal
pulser:
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0x6070 1

This line tells mvme to write the value 1 to register address 0x6070. The address is relative to the module
base address.

* Click the Apply button on the editors toolbar to commit your changes to the VME configuration. Close the
editor window.

3.2 Analysis Setup

* Activate the Analysis Ul window (the shortcut is Ct r1+2). The event containing the module just created
should be visible in the Ul

* Right-click the mdpp16 module and select Generate default filters. Choose Yes in the messagebox that pops
up. This will generate a set of data extraction filters, calibration operators and histograms for the module.

@ doc_guickstart.analysis - [Analysis UI]
© 5 (S -}
e R 4 (1] i = »
New Open Save Saveds ClearHistos  Debug & Stats  Pause Load Session
Event: evento - @ . w . = Repopulate [dev) = {5
Level Visiblity ~ Event settings Import
LO Parameter Extraction L1 Processing
i mdppl6_scp * [ Cal mdppl6_scp
3 amplitude v % cal amplitude
» 7 time » il Cal time
v timestamp v il Cal timestamp
» trigger_time v 5. Cal trigger_time

LO Raw Data Display L1 Data Display
~ [ mdppl6_scp * | cal Histos mdpp16_scp
bl H1D amplitude_raw » . H1D amplitude
b {jl. H1D time_raw v g H1D time
b {jl. H1D timestamp_raw b gl H1D timestamp
v {il. H1D trigger_time raw » gl H1D trigger time

Efficiency: 0.00 Timeticks: 0's Histo Storage: 35.00 MiB a2:

Fig. 3.5: Analysis UI with MDPP-16 default objects

3.3 Starting the DAQ

Activate the main window again (Ct r1+1). Make sure the VME Controller is shown as Connected in the top part
of the window.
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Start
Histo data: Keep ® Clear
VME Controller: Connected (MVLC_ETH) Settings
Reconnect
DAQ State: Idle

Analysis State: Idle
Listfile Qutput:

Write Listfile Compression:| Fast compression =

Run Settings | Workspace Settings

Current Filename:

Current Size: 0.00 B
Free Space: 256.51 GB

Fig. 3.6: DAQ control

Optionally uncheck the box titled Write Listfile to avoid writing the test data to disk. If left checked a listfile will
be created for each newly started DAQ run. This listfile is placed in the workspace directory under 1istfiles.
It is a standard ZIP archive containing the raw readout data and copies of the current analysis setup and the log
buffer contents.

The naming scheme of the listfiles can be adjusted via the Run Settings dialog. Note that mvme will never
overwrite existing listfiles even if you manually adjust the Next Run Number value.

Press the Start button to start the DAQ. Check the Log View (Ct r1+3) for warnings and errors.

In the Analysis UI double-click the histogram entry called amplitude_raw (bottom-left corner in the LO Data
Display tree) to open a histogram window.

If data acquisition and data extraction are working properly you should see new data appear in the histogram. Use
the spinbox at the top right to cycle through the individual channels.
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Histogram mdppl6.amplitude_raw[0]

Y-Scale ﬁ ii - H i ﬁ Histogram #
Lin = | Gauss Rate Est. Clear Exl;:-rt Save Subrange Resolution Info 0 -
1500 RMS 87.8485

7 FWHM 9.36172
] Mean 22472.4
: Max 22473.5
Maxy¥ 1361
w0 ]
E 1000 | Counts 13762
3 4
0 4
W) i
500
D_
L e e e e e e e e e e e ML B s s e e
0 10000 20000 30000 40000 50000 60000
amplitude[0]

Fig. 3.7: Amplitude histogram

You can pause and/or stop the DAQ at any time using the corresponding buttons at the top of the main window.

3.4 Event Counter readout

Optionally a second event used to read out the modules event counter registers can be created. This event will be

triggered periodically by the VME controller.
 Right-click Events, choose Add Event
* Set Condition to Periodic and the periodto 1.0s
* Right-click the newly created event, choose Add Module
* Select MesytecCounter as the module type

¢ Enter the same address as used for the MDPP-16 above
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CHAPTER
FOUR

REFERENCE

4.1 DAQ / Replay controls

Start
Histo data: Keep @ Clear
WME Controller: Connected (MVLC_ETH) Settings
Reconnect
DAQ State: Idle

Analysis State: Idle
Listfile Output:

Write Listfile Compression:| Fast compression -

Run Settings | Workspace Settings

Current Filename:

Current Size: 0.00 B
Free Space: 256.51 GB

Fig. 4.1: DAQ controls

The effects of the buttons depend on the current mode - DAQ or replay - and the current state of the system:

Table 4.1: DAQ control actions

Action DAQ mode Replay mode

Start Start replay fi beginni f fil
a * Run DAQ startup procedure art epiay Trom beginning ot e

* Open new listfile

St St d ind to beginni f
P * Run DAQ stop procedure ﬁ]Zp anc rewind to beginmng ©

¢ Close listfile

P P 1
ause « Leave DAQ mode ause replay

e No special procedures are
run

The Start button allows to choose what should happen with existing histogram data. Selecting Clear will clear all
histograms in the current analysis before accumulating new data ing Keep allows to accumulate the data from
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multiple replays or DAQ runs into the same histograms.
The Reconnect button will attempt to reconnect to the current VME controller.

If Write Listfile is checked a new output listfile will be created when starting a DAQ run. The file will be created
in the listfiles subdirectory of the current workspace. The filename is based off the current timestamp to make it
unique.

Use the Compression drop down to switch between a fast compression mode (ZIP level 1) and no compression at
all (ZIP level 0). Even without compression the raw readout data is still placed in a ZIP archive together with the
analysis and log buffer contents.

Note: testing showed that higher compression levels did not yield a significant increase in data reduction but had
a high performance impact so the higher level modes are not currently selectable via the GUL

Use the Run Settings button to change settings regarding the naming scheme of the listfiles produced during DAQ
runs.

The Workspace Settings dialog allows setting the experiment name (used by the ‘Event Server’ component) and
enabling/disabling the JSON-RPC and Event Server components.

4.1.1 Replaying from listfile

To replay data from a listfile use File -> Open listfile and choose a .zip or .mvmelst file.

When opening a listfile the VME config included inside the file is loaded and will replace the current config. The
global mode will be switched to Listfile. To go back to DAQ mode use File -> Close Listfile.

4.2 VME configuration

4.2.1 Structure

The VME configuration in mvme models the logical VME setup. Modules that should be read out as a result of
the same trigger condition are grouped together in an Event:

EventO
Module0.0
ModuleO.1

Eventl
Modulel.O
Modulel.1l

The type of available trigger conditions depends on the VME controller in use. With the WIENER VM-USB the
following triggers are available:

* NIM

One external NIM input
* IRQ1-7

The standard VME interrupts
* Periodic

VM-USB supports one periodic trigger which is executed every n * 0. 5s (Period) or on every m—th data
event (Frequency). If both values are set both internal counters are reset on each activation of the trigger.
Refer to section 3.4.3 of the VM-USB manual for details.
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4.2.2 Module and Event configuration
The module and event configuration is done using VME scripts which contain the commands necessary to initialize
and readout each module.
At the module level the following phases are defined:
* Reset
Reset the module to a clean default state.
e Init
Setup the module by writing specific registers.
* Readout
The code needed to readout the module whenever the trigger condition fires.
The event level distinguishes between the following phases:
» Readout Cycle Start / End

Inserted before / after the readout commands of the modules belonging to this event. The Cycle Start script
is currently empty by default, the Cycle End script notifies the modules that readout has been performed.
By default this is done by writing to the multicast address used for the event.

* DAQ Start / Stop

Executed at the beginning / end of the a DAQ run. The purpose of the DAQ Start script is to reset module
counters and tell each module to start data acquisition. DAQ End is used to tell the modules stop data
acquisition. By default both scripts again use the multicast address of the corresponding event.

4.2.2.1 Variables
Since mvme-0.9.7 both event and module configs can contain a set of variables whose values can be used inside
VME scripts.

Variables from the event scope are available inside the event scripts and all child module scripts. Variables defined
at module scope are available to the module init and readout scripts. Module variables override variables defined
at event scope.

When adding a new VME event a set of standard variables is created:
* sys_irq

A system variable which is automatically set to the IRQ value used to trigger the event or O if the event is
not IRQ triggered.

* mesy_mcst

Contains the highest 8-bits of the VME multicast (MCST) address setup for the event. This is used to
initialize the events member modules and to simultaneously write each of the modules readout_reset register
at the end of each readout cycle.

* mesy_eoe_marker
EndOfEvent marker for mesytec modules (register 0x6038).
. mesy_readout_num_events

Number of events to read out from each module per readout cycle. This is used to set the values of
the irg fifo_threshold (0x601E) and max_transfer_data (0x601A) of mesytec mod-
ule. By default irg_fifo_thresholdissettomesy_readout_num_events + 1.

The default VME templates shipped with mvme assume that the above variables are defined and contain valid
values for mesytec modules.
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In the GUI variables can be viewed, added and modified by editing the respective object (Edit Event Settings for
events, Edit Module Settings for modules).

For event configs there is also a special variable editor available via the Edit Variables action button or context
menu entry. This editor allows to edit variables during a DAQ run and automatically executes VME scripts that
are affected by changes to variable values.

w Variable Editor for Event 'event0’ (RS B

Event eventO

V| Auto-run dependent module init scripts on modification
v Auto-apply modifications to event config

v Show system and internal variables

(® Run dependent module init scripts

Event Variables Log View
Variable Name Variable Value Comment
sys_irq 1 IRQ value set for the VME Controller for this event.
integration_long 300 [ns]
integration_short 50 [ns]
mesy_eoe_marker 1 EndOfEvent markgr for mesytec modules {(_):
- - eventcounter, 1: timestamp. 3: extended_timestamp).
mesy mcst bb The most 5|gn|ﬁu?ant byte of the 32-bit multicast address
to be used by this event.
mesy_readout_num_events 1 Number of events to read out in each cycle.
pulser_amplitude 500 internal MDPP-32 internal pulser Amplitude; 100 to 4000
pulser_on 1 internal MDPP-32 pulser; one = 1; off = 0;
signal_amplitude 1000 Eg‘;\gb:almum is amplitude printed on the gain jumper
signal_threshold 1000 0 to 65536; referenced to short integrated signal.
signal_width 20 [ns]; width of the input signal (short signal from neutrino

interaction)

= Add new variable | =

o Apply || @cancel || oK

Fig. 4.2: Event Variable Editor with system and custom variables

4.2.3 DAQ startup procedure

* Reset and setup the VME controller
* Assemble readout code from configured Events
For each Event do:
— Add Cycle Start script
— For each Module:
% Add Module readout script
+ Add “Write EndMarker” command (0x87654321, not needed for the MVLC)
— Add Cycle End script
¢ Upload the readout code to the controller and activate triggers
» Execute global DAQ Start scripts, including the MVLC Trigger/IO script
* Initialize Modules
For each Event do:
— For each Module do:
* Run Module Reset
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# Run all Module Init scripts
— Run the Events Multicast DAQ Start script
¢ Set the controller to autonomous DAQ mode

Control is handed to the VME controller. mvme is now reading and interpreting data returned from the controller.

4.2.4 DAQ stop procedure

Tell the VME controller to leave autonomous DAQ mode

¢ Read leftover data from the VME controller

Run the DAQ Stop script for each Event
» Execute global DAQ Stop scripts

4.2.5 VME Controller specifics

4.2.5.1 Mesytec MVLC

To implement periodic events on the MVLC the global MVLC Trigger/IO script is modified by mvme when
starting a DAQ run: A StackStart unit is connected to a 7imers unit which is setup with the parameters from the
corresponding periodic event. The StackStart unit is then setup to start the command stack for the respective event.
These changes are visible in the MVLC Trigger/IO gui immediately after starting the DAQ.

4.2.5.2 SIS3153

If using the SIS3153 VME controller additional commands which activate Lemo OUT2 during execution of the
readout will be added to the script for the main readout event. The main event is considered to be the first non-
periodic event defined in the VME configuration.

OUT1 and LED_A are activated prior to entering autonomous DAQ mode and deactivated after leaving DAQ
mode.

4.3 VME Scripts

4.3.1 Overview

VME Scripts are plain text files with one command per line. Comments may be started using the # character.
They extend to the end of the line. Alternatively blocks can be commented out starting with / and ending with
*/.

Scripts belonging to a module (Module Init Scripts, VME Interface Settings, Module Reset and the readout
code) will have the module base address added to most of the commands. This allows writing scripts containing
module-relative addresses only. An exception is the writeabs command which does not modify its address argu-
ment. The base address can also be temporarily replaced with a different value by using the setbase and resetbase
commands.

The commands below accept the following values for address modifiers and data widths:

Table 4.2: VME Address Modes
Address Mode (<amode>)
al6
a24
a32

mesytec GmbH & Co. KG 2 1/75
Wernher-von-Braun-Str.1, D-85640 Putzbrunn, Germany
phone: +49 - 89 / 456007-30 fax: +49 - 89 / 456007-39
info@mesytec.com - www.mesytec.com



mvme - mesytec VME Data Acquisition

Table 4.3: VME Data Widths
Data Width (<dwidth>)
d16
d32

The combination of amode, dwidth and BLT/MBLT yields a VME address modifier to be sent over the bus.
Internally these non-privileged (aka user) address modifiers will be used:

Table 4.4: VME address modifiers used by mvme

amode | single | BLT | MBLT
Al6 0x29

A24 0x39 0x3b

A32 0x09 0x0b | 0x08

Numbers in the script (addresses, transfer counts, masks) may be specified in decimal, octal, hex or floating point
notation using the standard C prefixes (0x for hex, O for octal). Additionally register values may be written in
binary starting with a prefix of 0b followed by Os and 1s, optionally separated by ' characters.

Example: 0b1010'0101'1100'0011 isequal to 0xa5c3

4.3.2 Commands

4.3.2.1 Writing

* write <amode> <dwidth> <address> <value>
* writeabs <amode> <dwidth> <address> <value>
writeabs uses the given <address> unmodified, meaning the module base address will not be added.

There is a short syntax version of the write command: if a line consists of only two numbers separated by whites-
pace, a write using 32-bit addressing (a32) and 16-bit register width (d16) is assumed. The address is the first
number, the value to be written is the second number.

Example: 0x6070 3 isthe same aswrite a32 dl6 0x6070 3

4.3.2.2 Reading

e read <amode> <dwidth> <address>

Reads a single value from the given <address>.

4.3.2.3 Block Transfers

mvme supports the following read-only block transfer commands:
* blt <amode> <address> <count>
* bltfifo <amode> <address> <count>
* mblt <amode> <address> <count>
* mbltfifo <amode> <address> <count>
blt and bltfifo transfer <count> number of 32-bit words, mblt and mbltfifo transfer 64-bit words.

The *fifo variants do not increment the given starting address.
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4.3.2.4 Miscellaneous
wait

e wait <waitspec>

Delays script execution for the given amount of time. <waitspec> is a number followed by one of ns, ms or s for
nanoseconds, milliseconds and seconds respectively. If no suffix is given milliseconds are assumed.

Note: The wait command is only available when directly executing a script from within mvme. It is not supported
in command stacks for the MVLC and SIS3153 controllers.

The VMUSB has limited support for the wait command in command stacks with a waitspec resolution of 200 ns
and the maximum possible delay being 51000 ns.

Example: wait 500ms # Delay script execution for 500ms

marker

* marker <marker_word>

The marker command adds a 32-bit marker word into the data stream. This can be used to separate data from
different modules.

setbase/resetbase

¢ setbase <address>
¢ resetbase

These commands can be used to temporarily replace the current base address with a different value. setbase sets a
new base address, which will be effective for all following commands. Use resetbase to restore the original base
address.

write_float_word

¢ write_float_word <address_mode> <address> <part> <value>

The write_float_word command is a helper function for dealing with VME modules using IEEE-754 floating point
numbers internally (e.g. the ISEG VHS4030). The command writes a 16-bit part of a 32-bit float into the given
register without performing any integer conversions.

Arguments:
* address_mode
The VME address mode: al6, a24 or a32
* address
Address of the register to write to.
e part

One of upper / 1 and lower / 0. The upper part contains the 16 most significant bits of the float, the lower
part the 16 least significant bits.

e value

The floating point value using a . as the decimal separator.
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Example

write_float_word alé 0x0014 upper 3.14
write_float_word alé 0x0016 lower 3.14

Writes the 32-bit float value 3.14 to the two 16-bit registers Ox14 and 0x16.

4.3.2.5 VMUSB specific

* vmusb_write_reg (<register_address>|<register_name>) <value>
* vmusb_read_reg (<register_address>|<register_name>)

These commands only work when using the WIENER VM-USB controller and allow read/write access to its
internal registers. For details on the registers see the VM-USB manual section 3.4 - Internal Register File.

Instead of using register addresses some registers are also accessible via name. The following name mappings are
defined:

Table 4.5: VMUSB Register Names

Register Name | address
dev_src 0x10
dgg a Ox14
dgg b 0x18
dgg_ext 0x38
sclr_a Ox1c
sclr_b 0x20
daq_settings 0x08

4.3.3 Floating Point Values, Variables and Mathematical Expressions

Since mvme-0.9.7 VME scripts support evaluation of numerical expressions and can contain references to vari-
ables. Additionally floating point values can be used where previously only unsigned integers where allowed.

It is up to each specific command how floating point values are interpreted and what limits are imposed. The VME
read and write commands use mathematical rounding and test that the resulting value fits in an unsigned 16 or 32
bit integer (depending on the commands data width argument). On the other hand the write_float_word command
uses the floating point value directly without performing an integer conversion.

4.3.3.1 Variables

The variable system in VME Scripts is based on simple string replacement. Whenever a variable reference of the
form $ {varname} is encountered the value stored under the name varname is looked up and is used to replace
the variable reference. Variable expansion is currently not recursive so ${$ { foo} } will try to look up the value
of a variable named ${foo}.

Variables are stored in lists of symbol tables with the variables from the first (innermost) table overriding those
defined in the outer scopes.

Each object in the VME Config tree carries a symbol table: VME Events, VME Modules and VME Script objects
each have a set of variables attached to them. When parsing a VME script the list symbol tables is assembled by
traversing the VME Config tree upwards towards the root node. Each objects symbol table is appened to the list of
tables. This way variables defined at script scope take precedence over those defined at module scope. The same
is true for module and event scopes.

In addition to variables defined by VME Config objects variables can also be locally defined inside a VME Script
using the set command. The variable will be entered into the most local symbol table and will override any other
definition of a variable with the same name.
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The mvme GUI currently contains a dedicated editor for variables defined at VME Event scope. Select an event in
the VME Config tree and click the Edit Variables button above the tree. Module level variables can be accessed
via Edit Module Settings from the context menu. A dedicated editor for Module and Script objects is going to be
added in the future.

Example

set threshold 500
write a32 dl6 0x1234 ${threshold} # —-> write a32 dl16 0x1234 500

set addr 0x6789
set value 0b1010

write a32 dl6 ${addr} ${value} # —> write a32 dl16 0x6789 0b1010
S{addr} S${value} # same as above using the short form of the
—write command

4.3.3.2 Expressions

Mathematical expressions in VME scripts are enclosed between $ ( and ). The enclosed string (including the
outermost parentheses) is passed to the exprtk library for evaluation and the resulting value replaces the expression
string before further parsing is done.

exprtk internally uses floating point arithmetic and the result of evaluating an expression is always a floating point
value. It is up to the specific command of how the value is treated.

Variable references inside expressions are expanded before the expression is given to the exprtk library for evalu-
ation.

Example

# From the MDPP-32-QDC init script: Window start = 16384 + delayl[ns] / 1.56;
0x6050 $(16384 - 100 / 1.56)

# or using a local variable to hold the delay:
set my_delay -100
0x6050 $(16384 + S${my_delay} / 1.56)

4.3.4 Example Script

# BLT readout until BERR or number of transfers reached
bltfifo a32 0x0000 10000

# Write the value 3 to address 0x6070. If this appears in a module specific
# script (init, readout, reset) the module base address 1is added to the

# given address.

0x6070 3

# Same as above but explicitly using the write command.
write a32 dl6 0x6070 3

# Set a different base address. This will replace the current base address
# until resetbase is used.
setbase 0xbb000000

(continues on next page)
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(continued from previous page)

# Results 1in an a32/dl6 write to 0xbb006070.
0x6070 5

# Restore the original base address.
resetbase

# Binary notation for the register value.
0x6070 0b0000'0101

4.4 MVLC Trigger 1/0 Module

4.4.1 Introduction

The MVLC VME controller contains a digitial logic module enabling flexible configuration of readout trigger logic
and timings. The module includes setup of the front-panel NIM IOs and ECL outputs, internal logic functions,
signal routing and access to utilities like timers, counters and the VME system clock.

The low-level setup of the Trigger I/O module is performed by writing to special registers via MVLCs internal
VME interface at base address 0xf£f££0000. This means standard VME write commands can be used to setup
the module, create software triggers and read out counter values.

mvme contains a dedicated graphical interface representing the structure and internal connections of the logic
module. This interface shields the user from the low-level details, allows to use custom signal names and simplifies
creating complex setups. The low-level VME commands used to setup the logic module can still be viewed and
manually edited if needed.
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4.4.2 Structure and operation

NIM Inputs. [ o LUT2 NIM Qutputs
|
4
NIM13 | kL NIM13
3
NIML2 [, ) NiM12
| 04 [, wn NIk
i1 | ! | NIM1O
0 | g |
NIM1O 3 14 INIMQ
- H 14 INIMS
5 LUTL 1 og HIMT
NIME | 0 |NIME
~ 2 strobe GG I
M7 | ; L | NIMS
1
NIMG I 2 1 | HIMA
[, 0e [, o NIM3
NIMS 1 | Immz
4
[
NIM4 : 3 29 :NIMl
2 14
NIM3 | o
. LT i} 0
NIM2 | | 0
| < 24 strobe GG
NIM1 3
- 2 e | ECL Outputs
04 ECLZ
d ECLL
0 !eao
LO Utilities L3 Utilities
TTatch
Fm— =ysclk g Caunter Couniter? | Stack Start
IR stack_busyl § : ' Master Tri
@B stack_busyD § A her Counters aster Iriggers
Soft Triggers save trigger3 4 = ' Counters
Slave Trigger Input e 4 counter Counters |
Stack Busy - ot 1
: triggerl Counterd
VME System Clock slave triggerl “'t""t" |
soft_triggerl § Counter Counter3
soft_triggerD @ t
- 9;2]_: ca.-_,ﬁnw Counter2
.IROM (aﬂ[.im, Counterl |
timer3 A= 1
timer2 counter Counterd
timerl MasterTrigger3
t_counter_readout MasterTrigger2
MasterTriggerl
MasterTriggerQ
StackStart3
StackStart2
StackStart1
55_counter_readout

Fig. 4.3: Structure of the MVLC Trigger /O module

Logically the MVLC Trigger I/O module is divided into 4 levels with signals originating on the lowest level and
flowing through the system towards the higher levels.

Each of the levels contains a set of specific units representing functionality provided by the logic module. This
includes the NIM I/Os, timers, lookup tables, counters, access to command stacks etc.

The units from higher levels connect back to units from lower levels. Some of these connections are hardwired
while others can be dynamically selected from a set of options.

Level 0 contains signal-generating units like NIM inputs, the VME system clock and timers.

Levels 1 and 2 contain lookup tables which can be used to implement arbitrary boolean logic and route signals to

higher levels.

Level 3 consists of signal-consuming units like NIM outputs, counters and units for executing command stacks.

The delay introduced by the logic module for a signal travelling from a NIM input to a NIM output is 160 ns.
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4.4.3 User Interface and integration into mvme

Inside mvme the MVLC Trigger I/O module will appear as the topmost item in the VME Config tree when one of
the MVLC variants (USB or Ethernet) is selected as the VME Controller.

Object Info
s MVLC Trigger/lO
[ DAQ Start
« MY Events
- eventO Trigger=IRQ1
= [ Modules Init
* = mdppl6_scp Type=MDPP-16_SCP, Address=...
Module Reset
Module Init
Frontend Settings
| WVME Interface Settings
¥ [ Readout Loop
v ) Multicast DAQ Start/Stop
| DAQ Stop
[ Manual

Fig. 4.4: VME Config tree with the MVLC Trigger I/O module at the top

Double-clicking this module will open a dedicated GUI representing the current configuration of the logic module.
The view can be zoomed via the mouse wheel and panned by holding down the left mouse button and moving the
Cursor.

Each of the blocks can be double-clicked to open an editor window specific to the unit or groups of units. Input
and output pins are represented by small circles near the edges of each block. Connections between pins are drawn
as arrows from source to destination.

The user interface only draws arrows for connections it considers active. NIM and ECL units have their own
activation flags present in the hardware while other units such as timers - which interally are always active - have a
software-only activation flag. Lookup table inputs are only considered active if the corresponding input is actually
used in the logic function implemented by the LUT.

Each of the specific editor windows allows editing the names of input/output pins which makes routing and con-
necting signals easier.

By default changes made in any of the editor windows are applied immediately upon closing the editor or pressing
the Apply button as long as mvme is connected to an MVLC. This means the software representation of the
Trigger I/O module is converted to a list of VME write commands targeting the MVLC and then this command
list is directly executed. Use the Aut orun button from the top toolbar to toggle this behaviour.

If you want to view or edit the VME write commands directly use the View Script button, make your changes
inside the text editor that opens up and then press the Reparse from script button to update the user
interface.

Descriptions of the available units and their corresponding GUI editors can be found in /O and logic units.

When starting a new DAQ run the initialization procedure will apply the current logic setup to the MVLC before
further initializing any modules and setting up the readout stacks.
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4.4.3.1 Reserved logic units

To implement events that should be periodcally read out mvme reserves the first two timer and stack start units.
Currently these units are not available for modification in the user interface.

Whenever a periodic event is created the first available timer unit is setup with the events readout period. The first
available StackStart unit is then connected to the timer and setup to start the events readout command stack.

Note that if more than two periodic VME events are created, the rest of the Timer and StackStart units will also
be used by mvme. Having more than 4 periodic events defined in the VME config is not allowed and will lead to
an error at startup.

LO Utilities L3 Utilities
- sysclk lakch C ter7
Timers stack busyl counter COUNEErT | Syack Start
IRQs stack_busy0 BEh —ounters | Master Triggers
Soft Triggers N —— = ! Counters
} : trigg
Slave Trigger Input siave rigger counter Counters |
Stack Busy slave_triggerl o . Counterd
VME System Clock slave_triggerd : |
. lis
soft_triggerl counter Counter3
ft_trigger0
— n’l’;{;l &.'ﬁnw Counter2
IRQOD cautﬁ.-.ti.— Counterl
timer3
atch
timer2 counter Counterd |
timerl MasterTrigger3

t_counter_readout MasterTrigger2
MasterTriggerl
MasterTrigger0
StackStart3
StackStart2
StackStartl
s5_counter_readout

Fig. 4.5: Internal usage of Timer and StackStart units for a periodic VME event called counter_readout.

4.4.4 Gate Generators

Some of the Trigger I/O units have builtin gate generators to influence the signals they produce. These units are
the NIM I/Os, ECL outputs, LUT strobe inputs and the SlaveTrigger inputs. The gate generators share a common
set of properties:

* Delay
Delays generation of the output pulse by the specified time in nanoseconds.
Minimum: O - no delay, maximum: 65535 ns

* Width
The width of the generated pulse in nanoseconds. Setting the width to O disables the gate generator.
Minimum: 8 ns, maximum: 65535 ns.

* Holdoff
Holdoff sets the minimum time that must elapse before the next change to the output may occur.
Minimum: 0 ns, maximum: 65535 ns.

* Invert

By default output pulses are generated at the leading edge of the input signal. Setting the invert flag changes
this to the trailing edge.

Each gate generator can be disabled by setting its width to 0. In this case the signal is passed through as is. This
allows to make use of DC-level signals inside the logic (for example busy inputs from external hardware).
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4.4.5 1/0 and logic units
4.4.5.1 NIM I/Os
The front panel NIM connectors can be configured as either input or output. This means they are available both

on the levelO input side and on the level3 output side.

Each of the NIM I/Os is driven by a gate generator. When a NIM is configured as an input the gate generator is
used to generate the internal signal. If the NIM is configured as an output the gate generator effects the output
signal of the NIM.

Note that it is possible to use a NIM as both input and output at the same time. In this case the NIM has to be
configured as an output and the gate generator acts on the output signal only.

4.4.5.2 LVDS outputs

These are similar to the NIM output units. Each of the 3 outputs needs to be activated separately.

4.4.5.3 Timers

Fixed frequency logic pulse generation.

Settings

* Range
The time unit the timer period refers to. One of ns, us, ms or s.
* Period
The period in units specified by Range.
Minimum: 8 ns, maximum: 65535 s.
* Delay
Delays generation of the output pulse by the specified time in nanoseconds.

Minimum: O - no delay, maximum: 65535 ns

4.4.5.4 IRQ Units

Generates a signal when one of the 7 available VME IRQs triggers. The only setting is the number of the IRQ
(1-7) this unit should react to.

4.4.5.5 Soft Triggers

Software triggers which can either be permanently activated via the GUI editor or pulsed by executing one of the
folowing VME Scripts:

setbase 0xfff£f0000 # use the mvlc vme interface as the base address
0x0200 0x0006 # select soft_trigger0 (Level0.Unit6)
0x0300 1 # activate the trigger
setbase 0xff£f£f0000 # use the mvlc vme interface as the base address
0x0200 0x0007 # select soft_triggerl (Level0.Unit7)
0x0300 1 # activate the trigger
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To use the above scripts in mvme right-click the Manual section in the VME Config area and choose Add
Script, type a name and double-click the newly created script to edit it. Then paste the script text into the editor
and use the Run Script button to execute it.

4.4.5.6 Slave Triggers

Activates when one of the slave triggers fires. This feature will be available in the future with a special multi-crate
firmware and supporting software.

4.4.5.7 Stack Busy

The stack busy units are active while their corresponding VME command stack is being executed.

In the mvme user interface the command stack numbers are augmented with the event names defined in the VME
config.

4.4.5.8 Sysclk

This unit provides access to the 16 MHz VMEDbus system clock.

4.4.5.9 Lookup Tables (Levels 1 and 2)

The MVLC contains a set of lookup tables used to create logic functions and for signal routing. Each lookup table
(LUT) maps 6 input bits to 3 output bits. This allows to implement 3 functions each mapping 6 input bits to one
output bit or a single 6 to 3 bit function.

The first three LUTs on Levell are hardwired to the NIM inputs. There is some overlap as 14 NIM inputs are
connected to the 3*6=18 inputs of the first three LUTs.

The LUTs on level2 connect back to the levell LUTs and each has 3 variable inputs which can be connected to
the levell utility units or certain levell LUT outputs. Additionally the level2 LUTs each have a strobe input which
is used to synchronize the switching of the LUT outputs.
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L1

NIM Inputs

NIM13
NIM12
NIM11

NIM10

NIMT

NIMB

NIMS

NiM4

NIM3

NiM2

strabe GG
NiM1

NIMO

Fig. 4.6: The lookup tables with all hardwired connections active.

LUT Editor GUI

Editing of the LUT function is done via its own GUI:
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Dynamic LUT Inputs

Input2 | timer2 v
Inputl | timerl -

Input0 | timero -

Out0

Output Name:|L2.LUT0O.QUTO

Input Bit Usage

Lookup Table L2.LUTO Setup

Outl

Output Name:|L2.LUT0.0UT1

Input Bit Usage

Out2

Output Name: | L2.LUT0.0UT2

Input Bit Usage

Use Name Use Name Use Name
5 L1.LUT3.0UT2 5 L1.LUT3.0UT2 5/ W L1.LUT3.0UT2
4 L1.LUT3.0UT1 4 ¥ L1.LUT3.0UT1 4 L1.LUT3.0UT1
3 ¥ L1.LUT3.0UTO 3 L1.LUT3.0UTO 3 L1.LUT3.0UTO
2 timer2 2| W timer2 2 W timer2
1 timerl 1 | timerl 1 timerl
0 W timerD 0 timer0 0 timer0

Output Activation

Output Activation

Output Activation

AND OR INVERT AND OR INVERT AND OR INVERT
State State State
oo 0 Qoo 1 oo 0
01 0 0ol 1 01 0
10 0 010 1 10 0
11 0 011 1 11 0
100 1
101 1
Strobe Output: Strobe Output: Strobe Output:
Strobe Gate Generator Settings
Input Delay Width Holdoff
timer0 - .U 8 0
+ Apply @ cancel ok

Fig. 4.7: Editor window for a LUT on Level2.

Elements from top to bottom:

* Dynamic input selection for the first three inputs.

This only appears for LUTs on Level2. The drop down boxes are populated with the possible choices for
each of the dynamic inputs.

* Three columns of LUT functions, one for each of the three LUT output signals.

Each LUT maps 6 input bits to 3 output bits. This means a total of 26 = 64 input combinations per LUT.
To make editing easier only the combinations for selected input bits are shown.

Select the inputs you want to use via the checkboxes under Input Bit Usage. This will populate the
Output Activation table with the correct number of rows to represent each possible input combina-
tion.

Each row of the Output Activation table represents the state of the output for the corresponding
input combination. The input bit combination is shown on each row header with the lowest bit taking the
rightmost place. Click the button to toggle the output state for the corresponding input combination.
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Using the AND, OR and INVERT buttons allows to quickly populate the table with the corresponding func-
tion or invert the current assignment.

* For Level2 LUTs only: strobe input selection and parameters.

For Level2 LUTs an additional St robe Output checkbox is visible below the function table. If set the
corresponding output bit will be affected by the LUTs strobe input.

The strobe input signal can be selected from a predefined list and its gate generator parameters can be set
using the controls in Strobe Gate Generator Settings.

Note: mvme will attempt to minimize the boolean functions defined by each of the LUTs. This means that not
all selected input bits will necessarily be selected again when next opening the editor window but the resulting
function should be identical.

Example

outo
Output Name: L1.LUT3.0UTO

Input Bit Usage

Use Mame
5 L1.LUT1.0UTZ2
4 W L1L.LUT1.OUT1
3 L1.LUT1.OUTO
2 W L1L.LUTD.OUTZ2
1 L1.LUTO.OUTL
0 W Ll.LUTO.OUTO

Output Activation

AND OR INVERT
State
000 0
001 0
010 0
011 1
100 0
101 1
110 1
111 0

Fig. 4.8: Example LUT using input bits 0, 2 and 4. The output is activated if exactly two of the inputs are set.
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4.4.5.10 StackStart

These units start the execution of one of the 7 MVLC command stacks.

Settings

¢ Index of the command stack to execute
* Delay: the delay in ns until the stack execution is started
¢ Activation flag

In the mvme user interface the command stack numbers are augmented with the event names defined in the VME
config.

4.4.5.11 MasterTrigger

Generates a master trigger in multi-crate setups. This feature will be available in the future with a special multi-
crate firmware and supporting software.

4.4.5.12 Counters

8 64-bit counter units incrementing by one each time the input rises. Each counter has an optional latch input
which atomically transfers the current counter values to the counter registers. The latch can either be activated by
the Trigger/IO module or by writing to a special latch register.

The counter units can be read out via MVCLs internal VME interface at base address O0x££££0000 using the
following VME script:

setbase 0xfff£f0000

# counter0

0x0200 0x0308 # counter select

0x030a 1 # latch the counter (only needed if not done in the
—trigger_io module)

read a32 dle 0x0300 # counter readout

read a32 dl6 0x0302
read a32 dl6 0x0304
read a32 dl6 0x0306

# counterl

/%

0x0200 0x0309 # counter select

0x030a 1 # latch the counter (only needed if not done in the
—trigger_io module)

read a32 dl6 0x0300 # counter readout

read a32 dl6 0x0302
read a32 dl6 0x0304
read a32 dl6 0x0306
x/

A dedicated VME module called MVLC Timestamp/Counter is provided by mvme to ease setting up a
counter readout. Add an instance of this module to the VME Event where you want to read out the counter,
edit the readout script (under Readout Loop in the user interface) and comment out all the counter blocks
except for the one that should be read out.
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4.4.6 Examples

4.4.6.1 Sysclk timestamp readout

This example shows how to create a counter that increments with the VME system clock frequency and to read
out the counter values by creating a periodically triggered readout event.

Only an MVLC is required for this setup to work.

* Start by creating new vme and analysis configs in mvme. Make sure the VME controller type is set to one
of the MVLC variants and that mvme can succesfully establish the connection.

* In the VME Config tree right click the Events node and choose Add Event. Select Periodic as the

condition and accept the dialog.

Object Info
= MVLC Trigger/IO
[ DAQ Start

= Add Event :
=

Mame eventd

Condition | Periodic -

Timer Base  ms -

q P

Period Every 1000 ms

cancel ok

Creating the VME readout event

* Right-click the newly created event and select Add Module. Use the type drop-down and select MVLC
Timestamp/Counter. Accept the dialog to create a module which will read out CounterO of the Trigger
I/O module.
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Object Info
f= MVLC Trigger/IO
[ DAQ Start
« WY Events
-~ B8 eventD Trigger=Periodic
= [ Modules Init
* e mvlic_ts Type=MVLC Timestamp,/Count...
' Module Reset
| WVME Interface Settings
b [ Readout Loop
* [ Multicast DAQ Start/Stop
= DAQ Stop
] DAQ Stop
. Manual

Fig. 4.9: VME Config Tree after creating the event and adding the mvlc timestamp module

e Locate the Multicast DAQ Start/Stop node under the newly created event and double-click the
DAQ Start script it to open an editor window.

Add the following line to the script.

writeabs a32 dl6 Oxffff6090 1 # reset counters

This will make sure the counters are reset when starting a DAQ run.
* Double-click the MVLC Trigger/IO objectinthe VME Config tree to open the graphical editor.

* Double-click the L3 Utilities block. In the bottom-left select the input for CounterQO and set it to
sysclk. Also check the Soft Activate checkbox.

Counter? |LOUNTErs | umeru * | <NOT Connecreg= -
Counterl |Counterl  timerD * | =not connected> -
Counter0 CounterD sysclk = | =not connected> - v

Counter connected to sysclk and activated

e Now locate the Analysis UI window in mvme (Shortcut is Ctrl-2). eventO should show up in the Event
drop-down and the mvlc_ts module should be visible. In the top area right-click the mvlc_ts module and
select Generate default filters. Press ok to generate data extraction filters and histograms for
the counter readout data.

» Use the Start button in the top-left area of the main window to start a DAQ run. If everything is setup
correctly the DAQ should start successfully (DAQ State: Running) and an event rate of 1 count/s should be
displayed in the Analysis window for the mvlc_ts.timestamp data source.
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Event: eventd - P W @'
Level Visiblity  Ewvent settings Import
LO Parameter Extraction L1 Processing
* [ mvic_ts » [ Cal mvic_ts

« 7 timestamp
0 (hits=346, rate=1 cps, dt=1s)

L0 Raw Data Display L1 Data Display
* e mvic_ts b [ Cal Histos r
* {l. H1D timestamp_raw
0 (entries=346, rate=1 cps, dt=1

Efficiency: 1.00 Time

Running time: 00:05:46

Buffers read: 345

Buffer Errors: 0O

Data rates: 1.39 buffers/s, 0.00 MB/s
Avg. read size: 28

Bytes read: 0.01 MB
MWVLC ETH received packets: 346, 1 packets/s

MWVLC ETH lost packets: 0, 0 packets/s
MWLC Stack Errors:

DAQ and analysis stats during a run

* You can reopen the MVLC Trigger/IO object again and verify that mvme used the first timer together
with the first StackStart unit to implement the periodic readout for the event.

LO Utilities L3 Utilities
Timers sy=clk Gounter Counter? | stack Start
stack_busyl 1 R
IRQs stack_busyD cawjnw Counters | Master Triggers
Soft Triggers slave_trigger3 FC—  Counters
Slave Trigger Input  slave_trigger2 counter e
Stack Busy e Conter Counterd
slave_trigger( 4
VME System Clock soft_trigger] latch . Counter3
soft mg;:f taunter Counter2
IRQO counter Counterl
timer3 1
timer2 Zaunter Counter() |

MasterTrigger3
MasterTrigger2
MasterTriggerl
MasterTriggeri

t_eventD

StackStart3
StackStart2
StackStartl
s5_ayentd
Internal Timer and StackStart usage by mvme
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4.5 Analysis

4.5.1 User Guide

4.5.1.1 Ul Overview

The Analysis system in mvme is designed to allow
* flexible parameter extraction from raw readout data.
* calibration and additional processing of extracted parameters.

 accumulation and visualization of processed data.

The user interface follows the structure of data flow in the system: the modules for the selected Event are shown

in the top-left tree.

The bottom-left tree contains the raw histograms used to accumulate the unmodified data extracted from the

modules.

The next column (Level I) contains calibration operators in the top view and calibrated histograms in the bottom

view.
Event Select Add/Remove Level
E WME Module O
@
E Data Extraction
(1
'g WIME Module 1
&
==
=]
g
© Raw Histograms Calibrated Histograms Us_er-defmed
é Histograms
8
(=]

Level O Level 1 Level 2

Fig. 4.10: Analysis UI Block Diagram

Note: To get a set of basic data extraction filters, calibration operators and histograms right-click on a module an
select Generate default filters.

User Levels are used to structure the analysis and it’s completely optional to have more than two of them. Addi-
tional levels can be added/removed using the + and - buttons at the top-right. Use the Level Visibility button to
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select which levels are shown/hidden.

The Ul enforces the rule that operators can use inputs from levels less-than or equal to their own level. This means
data should always flow from left to right. This restriction does not apply to data sinks in the bottom tree. These
can be freely placed on any userlevel in the bottom tree.

Operators can be moved between levels by dragging and dropping them.

Event:| event0 ~ || @ Level Visiblity = (=
L0 Parameter Extraction L1 Processing L2 Processing =
¥ = mdppl6 P calmdpplEamplitude ™ » = Mean mdppl&.amplitude. sum

» T mdppl&.amplitude b 52 Cal mdppl6.event_counterfts

» 7 mdppl6.event_counterfts b L Cal mdppl6.time

» T mdppl6.time b 5 Cal mdppl6.trigger_time

» T mdppl6.trigger_time

L0 Raw Data Display L1 Data Display L2 Data Display
¥ [ mdppl6 * 1D + 1D
b gl H1D mdppls amplitude_raw » | H1D mdppl&.amplitude b gl H1D mdppl&.amplitude.sum
b gl H1D mdppl6&.event_counter) b g H1D mdpplé&.event_counter/ 2D
b gl H1D mdppl6.time_raw b gl H1ID mdpplé.time
b gl H1D mdpplé6.trigger_time_ra b gl H1D mdpplé&.trigger_time
2D

-

Histo Storage: 35.50 MiB

Fig. 4.11: Analysis UI Screenshot
The Calibration for mdpp16.amplitude is selected. Its input is shown in green. Operators using the calibrated data are shown
in a light blueish color.

Selecting an object will highlight its input data sources in green and any operators using its output in blue.

4.5.1.2 Adding new objects
Right-click in any of the views and select New to add new operators and histograms. A dialog will pop up with
input fields for operator specific settings and buttons to select the operators inputs.

Clicking any of the input buttons will make the user interface enter “input select mode”. In this mode valid outputs
for the selected input are highlighted.
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-+

L1 Processing *| L2 Processing
» .1 Cal mdppls amplitude F E Mean mdppl&.amplitude. su
v #0 "Output" (16 elements)

(0]

(1]

(2]
[3] Input
{;} ' [ mdppl&.amplitude[3] ] Q|
(6] :
(7] Name 'mdppl6.amplitude[3].rangeld |

{g} Min Value | 0.00000000 2]
ol " Max value |65536.00000000 B

MNew 1D Range Filter

L1 Data Display

v 1D '@ Keep if inside range ) Keep if outside range
P gl H1D mdppl&.amplitude |
P gl H1D mdppl6.event_coun
P gl H1D mdpplé.time
P gl H1D mdpplé&.trigger_time
2D

oK || Ccancel |

Fig. 4.12: Input select mode
Adding a /D Range Filter to Level 2. Valid inputs are highlighted in green.

Click an input node to use it for the new operator. If required fill in any additional operator specific data and accept
the dialog. The operator will be added to the system and will immediately start processing data if a DAQ run or
replay is active.

For details about data extraction refer to Data Sources. Descriptions of available operators can be found in Oper-
ators. For details about 1D and 2D histograms check the Data Sinks section.

4.5.1.3 Working with histograms
1D and 2D histograms are shown in the bottom row of the user interface. Raw 1D histograms are grouped by
module in the bottom-left LO Raw Data Display area. Higher level data displays are grouped by histogram type.

New histograms can be added by right-clicking in one of the data display areas, selecting New and choosing the
histogram type.

1D

1D histograms can take full arrays as input parameters. Internally an array of histograms of the same size as the
input array will be created.

Double-click on the H1D node to open the histogram array widget:
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Y-Scale .ﬁi .ﬁi — H t“ ﬁ 3 u Histagram #

Lin * | Gauss Rate Est. Clear Ex;:nrt Sawve Subrange Resolution Calibration | Infe 3 :
1 b
e RMS  1.5227
i FWHM 337677
7 Mean 495,982
R Max 499,611
] Maxy 420
& 300 4 Counts 100000
c ]
g 4
) 200 7
100

— T

485 490 495 500 505 510 515
amplitude[3]

®=493.731 Underflaw: 0

§=U Overflow: 0
in=32357

low edge=493.729

Fig. 4.13: 1D Histogram Array Widget

The histogram index can be changed using the spinbox in the top-right corner.

Zooming is achieved by dragging a rectangle using the left mouse button. Zoom levels are stacked. Click
the right mouse button to zoom out one level.

Press the Info button to enable an info display at the bottom-right of the window. This will show the current
cursor coordinates and the corresponding bin number.

Y-Scale

Toggle between linear and logarithmic scales for the Y-Axis.
Gauss

Fit a gauss curve through the currently visible maximum value.
Rate Est.

Rate Estimation feature.

Refer to Rate Estimation Setup for a how-to guide.

Clear

Clears the current histogram.

Export

Allows exporting to PDF and various image formats. Use the file type selection in the file dialog to choose
the export format.

Save
Saves the histogram data to a flat text file.

Subrange
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r

An

Allows limiting the range of data that’s accumulated. Only input values falling within the specified interval
will be accumulated.

This does not affect the histogram resolution: the full range of bins is still used with the limits given by the
subrange.

Resolution
Change the resolution of the histogram in powers of two from 1 bit to 20 bits.

This will not rebin existing data. Instead the histogram is cleared and new data is accumulated using the
newly set resolution.

Calibration

This button is enabled if the histograms input is a Calibration Operator and allows to directly modify the
calibration information from within the histogram:

Y-Scale ﬂ .ﬂ - H E o ﬁ Histogram #
Lin = | Gauss Rate Est. Clear Exl;c.-rt Save Subrange Resolution | Calibration | Infa | ¥ =
4 k
] RMS 24,5674
7 FWHM  1.1509
5000 Mean 614,189
1 Max 614,876
4000 —: Max¥ 4931
e . Counts 853337
C ]
3 3000 o ﬁ,E Adjust Calibration + 0 X
8 E Actual Target
2000 0.0000 2| o.0000 -
1000 _E £14.8834 - | §00.0000| p
. l is., Max J Apply
0 - Close
L B e m e e e e e , ,
560 580 G500 520 540 660

amplitude[0]

Fig. 4.14: Calibration adjustment from within the histogram display

The two inputs in the Actual column refer to the current x-axis scale. The inputs in the 7arget column are
used to specify the desired x-axis values.

Click on one of the Actual inputs and then press the Vis. Max button to fill in the x-coordinate of the
currently visible maximum value. Then enter the new x-coordinate value in the Target box and press Apply.

In the example above it is known that the peak should be at x = 600.0. The current x-coordinate of the
peak was found using the Vis. Max button. Pressing Apply will modify the calibration for that particular
histogram.

To see a list of calibration values for each channel open the Analysis UI (Ct r1+2), right-click the Calibra-
tion Operator and select Edit.

2D combined view

A combined view of the histograms of an array of parameters can be opened by right-clicking a H1D node
and selecting Open 2D Combined View. This option will open a 2D histogram with one column per 1D
histogram in the array.
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The X-axes of the 1D histograms are plotted on the combined views Y-axis, the values of the histograms
are plotted in Z.

This view allows to quickly see if any or all channels of a module are responding.

Z-5cale .ﬁ .ﬂ - = B ﬁ

Log ¥ | X Praj Y-Proj Clear Export Infa

1000 T . - le+06
aoo |0 - 100000
i _ 10000
_ - 0
600 i i E
9 — 1000 5
400 — I =
] = 100
200 ] - 10
I 1 | 1 I 1 | 1 I 1 | 1 I 1 | 1 I 1 | 1 I 1 | 1 I 1 | 1 I 1 | T I
0 2 4 =} 8 10 12 14 16
Fig. 4.15: 2D Combined View of MDPP-16_SCP amplitude values
Channels 0 and 8 are producing data with visible peaks at around 0 and 230.
2D

2D histograms take two single values as their inputs: the X and Y parameters to accumulate. When selecting the
inputs you will need to expand other operators and select the desired index directly.
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ﬁ,! New 2D Histogram A+ O X
Inputs
jrams
X-Axis mdppl&.amplitude [0] Q
Y-Axis <select> ] Q
L1 Processing
= 5. Cal mdppl6.amplitude MName
w #0 "Output" (16 elements) _ :
0] X Title mdppl6&.amplitude[0]
[1] ¥ Title
(2]
[3] X Resolution 1024, 10 bit -
(4]
(5] ¥ Resolution | 1024, 10 bit -
(6]
[7] X Limits
(8] k-

Fig. 4.16: Adding a 2D Histogram

Expand operator outputs and select individual indices for both axes.

Optional range limits can be specified for the axes. If enabled only values falling within the given interval will be
accumulated.

Double-click on a H2D node to open the histogram widget:
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Z-5cale ﬁ _ﬂf w *1, e o

Log ™ | %.Praj Y-Proj Clear FExport Subrange Resolution | Infa

L | ]
i — S— ]
— 700 — - 10000
E 3 |
X 600 I
— ] - 1000
= 500 3 i o
8 oo - 5
3 400 3 - 100
= . [
0 300
E ]
o 200 - 10
100 -
s L1
T T T I T T T T I T T T T I T T T T I T T T T I T T T T I 1
300 400 500 600 700 800
amplitude[0] [kev]
#¥=505.924, v=473.789, z=19 Counts: 1.84176e+6
xbin=250, ybin=215 MaxZ; 54347 @ (508,352, 508.299)

Fig. 4.17: 2D Histogram Widget

* Zooming is achieved by dragging a rectangle using the left mouse button. Zoom levels are stacked. Click
the right mouse button to zoom out one level.

* Press the Info button to show histo and cursor coordinate information at the bottom of the window.
* Z-Scale

Toggle between linear and logarithmic scales for the Z-Axis.
* X- and Y-Proj

Create the X/Y-Projection and open it in a new 1D histogram window. The projection will follow any
zooming/scrolling done in the 2D histogram.

* Clear
Clears the histogram.
* Export

Allows exporting to PDF and various image formats. Use the file type selection in the file dialog to choose
the export format.

* Subrange

Allows limiting the range of data that’s accumulated. Only input values falling within the specified interval
will be accumulated.

This does not affect the histogram resolution: the full range of bins is still used with the limits given by the
subrange.

Can optionally create a new histogram with the specified limits instead of modifying the current one. The
newly created histogram will be added to the analysis.

¢ Resolution
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Change the resolution of the histograms axes in powers of two from 1 bit to 13 bits.

This will not rebin existing data. Instead the histogram is cleared and new data is accumulated using the
newly set resolution.

4.5.2 System Details

As outlined in the infroduction the analysis system is a set of interconnected objects with data flowing from
Sources through Operators into Sinks.

The system is structured the same way as the VME Configuration: VME modules are grouped into events. An
event contains the modules that are read out on activation of a certain trigger condition. The result of the readout
is the modules event data (basically an array of 32-bit words). This module event data is the input to the analysis
system.

When processing data from a live DAQ run or from a listfile replay the analysis system is “stepped” in terms of
events: in each step all the Data Sources attached to a module get passed the modules event data. The task of each
source is to extract relevant values from its input data and make these values available to subsequent operators and
sinks.

After all sources have processed the module event data, the dependent operators and sinks are stepped in order.
Each object consumes its input and generates new output or in the case of sinks accumulates incoming data into a
histogram.

Event _ _ _ _ __ raw module data parameter array

Module 0 .E_/) Terae /’ -\

Module 1 i—} Source — - — -
Ty ¢ ¢

Sink Sink Sink

Fig. 4.18: Example analysis dataflow

4.5.2.1 Parameter Arrays

The transport container carrying data between objects is the Parameter Array:

Parameter Array

size | unit label
Parameters

0 value | valid | limits
1 value | valid | limits
2 value | valid | limits

size-1 | value | valid | limits

The size of parameter arrays is determined at analysis startup time and is constant throughout the run. The unit
label is a string which currently can be set through the use of the Calibration Operator. The index of a parameter
in the array is usually the channel address that was extracted from the modules data.

Each parameter has the following attributes:
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* value (double)
The parameters data value.
* valid (bool)
True if the parameter is considered valid, false otherwise.

A parameter can become invalid if for example a data source did not extract a value for the corresponding
channel address or an operator wants to explicitly filter out the address or could not calculate a valid result
for the input value.

e [imits (two doubles)

Two double values forming the interval [lowerLimit, upperLimit) that the parameters value
should fall into. This is used by histogram sinks and calibration operators to determine the parameters
range and thus calculate the binning.

4.5.2.2 Connection types

Different operators have different requirements on their input types. The Calibration Operator for example can
use whole parameter arrays as its input, transforms each data value and produces an output array of the same size
as the input size.

Other operators can only act on individual values and thus connect directly to a specific index into the parameter
array. An example is the 2D Histogram Sink: it requires exactly two input values, X and Y, neither of which can
be an array.

FParameters

I: Full &ray
3

FParameters

|"_ ide = 4

Fig. 4.19: Example of different input types

Each Operator implementation decides which types of input connections it accepts. Some operators even change
the type of inputs they accept based on the first input type that is connected (they either accept full arrays for all
their inputs or single values for all their inputs)
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The Analysis UI will highlight valid input nodes in green when selecting an operators input.

4.5.3 Data Sources

Analysis Data Sources attach directly to a VME module. On every step of the analysis system they’re handed all
the data words produced by that module in the corresponding readout cycle. Their job is to extract data values
from the raw module data and produce an output parameter array. Currently there’s one Source implemented: The
Filter Extractor

4.5.3.1 Filter Extractor

The Filter Extractor uses a list of bit-level filters to classify input words and extract address and data values.

Filter Basics

A single filter consists of 32 characters used to match a 32-bit data word. The filter describes the static parts of
the data used for matching and the variable parts used for data extraction. The first (leftmost) character of a filter
line matches bit 31, the last character bit 0.

The following characters are used in filter strings:

Character | Description

0 bit must be cleared
1 bit must be set

A address bit

D data bit

others don’t care

The following conventions are used in the default filters that come with mvme:
* X is used if any bit value is allowed.
* O (the letter) is used to denote the position of the overflow bit.
* U is used to denote the position of the underflow bit.
* P is used to denote the position of the pileup bit.

These characters are merely used to make it easier to identify certain bits when editing a filter. With regards to
matching any character other than 0 or 1 means that any bit value is allowed.

Example: The default Amplitude filter for the MDPP-16_SCP:

0001 XXXX POOO AAAA DDDD DDDD DDDD DDDD

The filter above contains a 4-bit address and a 16-bit data value. The positions of the pileup and overflow bits are
marked using P and O. This helps when adjusting the filter to e.g. match only pileup data (replace the P with a 1).

The number of address bits (A) determine the size of the Filter Extractors output array.

Data extraction from an input data word is done by keeping only the bits matching the address or data mask and
then right shifting to align with the O bit.

Note: Address and data bit masks do not need to be consecutive. AOAA will produce 3-bit address values by
gathering all extracted A bits on the right: 0AAA.

Each filter has an optional word index attached to it. If the word index is set to a value >= 0, then the filter can
only produce a match on the module data word with the same index.
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Multiple filter words

The Filter Extractor implementation allows combining multiple 32-bit filters to match and extract data from mul-
tiple input words.

Filters are tried in order. If a previously unmatched filter produces a match no further filters will be tried for the
same data word.

Once all individual filters have been matched the whole combined filter matches and address and data values can
be extracted.

When extracting values the filters are again used in order: the first filter produces the lowest bits of the combined
result, the result of the next filter is left-shifted by the amount of bits in the previous filter and so on.

Note: The maximum number of bits that can be extracted for address and data values is limited to 64.

See Timestamp extraction for an example of how a multiword filter can be used.

Matching and data extraction

During a DAQ run or a replay the Filter Extractor gets passed all the data that was produced by a single module
readout (Event Data). Each data word is passed to the internal filter.

Once the filter has completed Required Completion Count times address and data values will be extracted.

The data value is cast to a double and a uniform random value in the range [0, 1) is added. This resulting value
is stored in the output parameter array at the index specified by the extracted address value.

User Interface

In the Analysis Ul right-click a Module and select New -> Filter Extractor to add a new filter.
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I New Filter Extractor + 0O X
Filter # Filter String Wordindex
Filter 0 |0001 XXXX POOO AAAA DDOD DODOD DDDD DDDD any L=
Mame mdppl&.amplitude

Required Completion Count |1

v| Generate Histograms

Unit Label
Unit Min | 0.00000000 -
Unit Max | 65336.00000000 -
+ |Load Filter Template
0K Cancel

Fig. 4.20: Filter Extractor Ul

Use the + and - symbols to add/remove filter words. The spinbox right of the filter string lets you specify a word
index for the corresponding filter.

Required Completion Count allows you to specify how many times the filter has to match before it produces data.
This completion count starts from O on every module event and is incremented by one each time the complete
filter matches.

If Generate Histograms is checked raw and calibrated histograms will be created for the filter. Unit Label, Unit
Min and Unit Max are parameters for the Calibration Operator.

Predefined filters can be loaded into the UI using the Load Filter Template button.

4.5.4 Operators

The following operators are currently implemented in mvme:

4.5.4.1 Calibration
The calibration operator allows to add a unit label to a parameter array and to calibrate input parameters using
unitMin and unitMax values.

Each input parameters [lowerLimit, upperLimit) interval is mapped to the outputs [unitMin,
unitMax) interval.
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Calibration

cal itbrate{In[1]] out
Unit a

In Out[i]
a Out. Unit

With calibrate():

Out = (In - lowerLimit) + (unitMax - unitMin) / (upperLimit - lowerLimit) + unitMin

Limits can be specified individually for each address in the input array. Use the Apply button to set all addresses
to the global min and max values.

Input
mdppl6.amplitude (%
MName mdppl&. amplitude
Lnit Label
LInit Min 0.00000000 -
Linit Max | 975.79476044 -
+ Apply

Address Min Max =
0 0 975,795
1 0 1000
2 0 1000
3 0 1000
4 0 1000
o 0 1000
(5] 0 1000
7 0 1000
B ] 1000 i

oK Cancel
Fig. 4.21: Calibration Ul
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Note: Calibration information can also be accessed from adjacent 1D histograms. Refer to Working with 1D
Histograms for details.

4.5.4.2 Previous Value

Outputs the input array from the previous event. Optionally outputs the last input that was valid.

Previous Value

Out[1] = Prev[i]

I - out 5
if not KeepValid or In[i1].valid:

Prev[i] = In[i]

Event 0 — 95, Out Invalid o
Event 1 In 1
t
Event 2 out 0 >
In 2
ot 1
>

Y

Fig. 4.22: Behaviour of Previous Value over time.

If keepValid is set the output will always contain the last valid input values.

This operator can be combined with the Difference Operator to accumulate the changes of a parameter across
events. See Rate Estimation Setup for an example.

4.5.4.3 Difference

Produces the element-wise difference of its two inputs A and B:
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Difference

g _ |outrin = ati1 - era) —Qut 5

The output unit label is taken from input A. If A[i] or B[1] are invalid then Out [1] will be set to invalid:

Out.Unit = A.Unit

Out [i].lowerLimit A[i].lowerLimit - B[i].upperLimit
Out [i] .upperlLimit = A[i].upperlLimit - B[i].lowerLimit
Out[1i].value = A[i].value - B[1].value

4.5.4.4 Sum / Mean

Calculates the sum (optionally the mean) of the elements of its input array.

This operator produces an output array of size 1.

Sum / Mean

Out[0] = Sumlin[0..M-1]1)

In out
E if calcMean: E

Out[0] = Outo] J N

When calculating the mean the number of valid input values is used as the denominator.

4.5.4.5 Array Map

Allows selecting and reordering arbitrary indices from a variable number of input arrays.

Array Map

In#F0
In#F 1

m Out[1] = Maplii, Inputs) &
In#NE

The mappings are created via the user interface:
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!l! New Array Map + 0O X
Input
Input0 | mdppl &.amplitude | D
Inputz1 | mdppl&.time =)
+][=

Name mdppl6.amplitude.map |

Input - Output

mdppl&. amplitude[5] mdppls.amplitude[0]
mdppl&.amplitude[&] mdppl&.time[0]
mdppl&. amplitude[7] mdppl6.amplitude[l1]

mdppl&.amplitude[8] mdpplé.time[l]

mdppl&. amplitude[9] = mdpplé.amplitude[2]

mdppl&.amplitude[10] mdpplé.time[2]
mdppl&. amplitude[11] mdppl6. amplitude[15]
mdppl&.amplitude[12] - mdppl6&.time[15]

. oKk || cancel |

Fig. 4.23: Array Map Ul

* Use the + and - buttons to add/remove inputs. The elements of newly added inputs will show up in the left
Input list.

¢ Select elements in the Input and Output lists and use the arrow buttons to move them from one side to the
other.

Multiple items can be selected by control-clicking, ranges of items by shift-clicking. Both methods can be com-
bined to select ranges with holes in-between them. Focus a list and press Ct r1-A to select all items.

4.5.4.6 1D Range Filter

1D Range Filter

inside = In[i] in (min, max)
if (inside and keepInside)
N or [linside and 'keepInside): out
3 Out[1] = In[ 1] 3
else
Out[1].Valid = False
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Keeps values if they fall inside (optionally outside) a given interval. Input values that do not match the criteria are
set to invalid in the output.

4.5.4.7 2D Rectangle Filter

2D Rect Filter

%ﬁ ¥Inside = InX in (xMin, xMax)

¥Inside = InY in (¥Min, vMax)

Out[8].Valid = out
Cond == AND a

L- ? (xInside and yInside)

(xInside or yInside)

Produces a single valid output value if both inputs satisfy an interval based condition.

4.5.4.8 Condition Filter

Condition Filter

II.‘Jataa

if Cond[i].val id:
Out[i] = Datali] Out

cond else: %‘

% Out[1i].valid = False

Copies data input to output if the corresponding element of the condition input is valid.

4.5.4.9 Expression Operator

This operator uses the exprtk library to compile and evaluate C-like, user-defined expressions.

The operator supports multiple inputs and outputs. The definition of the outputs is done using an exprtk script,
which means arbitrary calculations can be performed to calculate the number of outputs, their sizes and their
parameter limits.

During analysis runtime a second script, the step script, is evaluted each time event data is available. The script
calculates and assigns parameter values to the operators output arrays.

Details about the syntax and semantics are provided in the online help in the Expression Operator user interface.

4.5.5 Data Sinks

mvme currently implements the following data sinks:
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4.5.5.1 1D Histogram

Accumulates incoming data into 1D histograms. Accepts a full array or an individual value as input. If given a
full array the number of histograms that will be created is equal to the array size.

See Working with 1D histograms for usage details.

4.5.5.2 2D Histogram

Accumulates two incoming parameters into a 2D histogram. On each event input data will only be accumulated if
both the X- and Y inputs are valid.

See Working with 2D histograms for details.
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4.5.5.3 Export Sink

A Edit File Export z =]
Inputs
Condition Input (optional) <select> %]
Data Input #1 PMT.X_sums %]
Data Input #2 PMT.Y_sums %]
Data Input #3 PMT.X_coord %]
Data Input #4 PMT.Y coord %]
Data Input #5 PMT.Y_sums.sum %]
e || =

Mame sumsAndCoords
Output Directory exports/sums_and coords Select
Format Indexed / Sparse -
Compression zlib fast -
Code generation

Important: Code generation will overwrite existing files!

Set the output path and export options above, then use the

buttons below to generate the code files.

Errors during code generation will be shown in the Log Window.

C++ & Python code

Cancel 0K

Implements data export to binary files and C++/Python example code generation.

The Export Sink has a variable number of data input arrays that will be written to disk. Additionally a single
parameter condition input can be used to pre-filter data: output data will only be generated if the condition input
is valid.

For each DAQ run or replay an export file named data_<runid>.bin is generated and the data from each event is
appended to that file. If zIib compression is enabled the extension .bin.gz is used.
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The inputs define the layout of the exported data (in the case of the “Plain/Full” format the export file contains
plain, packed C-structs).

Use the “C++ & Python Code” button to generate code examples showing how to read and work with export data.

To compile the C++ code run cmake . && make inside the export directory. The CMake file will try to find a
ROOT installation using the environment variable $ {ROOTSYS} and will search for zlib in the standard system
paths.

Most of the generated executables take an export binary file as their first command line argument, e.g:

./root_generate_histos my_run_001.bin.gz

4.5.5.4 Rate Monitor
The rate monitor uses its input values as precalculated rates or calculates the rate using the difference of successive
input values. Rate values are kept in a circular buffer and a plot of the rate over time can be displayed.

Details can be found in the Rate Monitor user interface.

4.5.6 Loading foreign analysis files

Internally VME modules are uniquely identified by a UUID and the module type name. This information is stored
in both the VME and analysis configs.

When opening (or importing from) a “foreign” analysis file, module UUIDs and types may not match. In this case
auto-assignment of analysis objects to VME modules is tried first. If auto-assignment is not possible the “Module
assignment” dialog will be shown.

Analysis to VME module assignment

VME

MyMDPP mgdec32 tdcl tdcz

mdppl6 mgdc32 mtdc32 mtdc32 discard

madc32
W madc32

T mdpplé.1
mdpplé&

mdppl&.2
mdpplé&

mtdec32.1
mtdc3z

mtde32.2
mtdc32

Analys

» Columns show possible destination modules present in the current WME configuration.
» Rows contain modules from the source analysis.
» Use the discard column to exclude a source module from the resulting analysis.

| (8] 4 Cancel

Fig. 4.24: Module assignment dialog

Each row contains one module present in the analysis that’s being opened/imported. The columns contain the
modules present in the local VME configuration.
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Use the radio buttons to assign analysis objects to VME modules. Select discard to completely remove the
corresponding module from the analysis.

If the dialog is accepted the source objects UUIDs will be rewritten to match the VME object ids. This will modify
the in-memory analysis.

4.5.7 More Ul structuring and interactions

4.5.7.1 Directories

Analysis Directory objects can be created in all but the first userlevels (L > 0). Directories are placed in either
the top or bottom trees and keep that assignment throughout their lifetime. Directories can contain any analysis
objects from the corresponding tree and other subdirectories.

Creating a new directory is done via New -> Directory in the context menu.

A directory can serve as the destination of a Drag and Drop operation. All moved objects will be reparented to
this destination directory.

4.5.7.2 Drag and Drop
Objects can be moved in-between trees by dragging and dropping. Selected objects from the source tree will be

moved to the destination tree. If the destination is a directory all dropped objects will be reparented into that
directory.

4.5.7.3 Multiselections

By holding Ctrl and clicking analysis objects it is possible to create a (cross-tree) multiselection. Combine holding
Ctrl and Shift at the same time to add ranges of objects to an existing selection.

Note: Cross-tree multiselections do not apply to drag and drop operations as these start and end on specific trees.
Thus using a cross-tree selection as the source of a drag operation would be counterintuitive.

4.5.7.4 Copy/Paste

Object selections can be copied to clipboard by using Ctrl-C or choosing Copy in a context menu.
Pasting is done via Ctrl-V or Paste in a trees or directories context menu.

If a selection containing internally connected objects is pasted the connections will be restored on the newly
created copies of the original objects. This way a network of operators and sinks can be duplicated quickly as only
the “external” inputs will need to be reconnected on the copies.

If a directory has been copied the paste operation will create clones of the directory and all of its subobjects.

Copy/paste of data sources is possible but newly pasted objects will not be assigned to a specific module yet.

4.5.7.5 Import/Export

A way to share parts of an analysis is to export a cross-tree multiselection to file and later on import from file.
Use the Export and Import toolbar entries in the analysis UI to perform these actions.

The behavior is similary to the copy/paste operations: all selected objects will be exported to file. On import clones
of these objects are created, internal connections are restored and all objects are placed in the same userlevels as
their originals.
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4.6 JSON-RPC remote control support

MVME uses the jsonrpc specification to implement basic remote control functionality. To enable/disable the
RPC-Server use the “Workspace Settings” button in the DAQ Controls Window and follow the instructions there.

If the RPC-Server is enabled mvme will open a TCP listening socket and accept incoming connections. By default
mvme binds to all interfaces and listens on port 13800.

Requests are currently not length-prefixed, instead data is read until a full JSON object has been received. The
received JSON is then interpreted according to the JSON-RPC spec.

Note: The JSON-RPC batch feature is not supported by the server implementation.

A command line client written in Python3 can be found in the mvme distribution under extras/
mvme_jsonrpc_client.py:

$ python3 extras/mvme_jsonrpc_client.py localhost 13800 getDAQState
—-==> {"id": "0", "Jjsonrpc": "2.0", "method": "getDAQState", "params": []}
<——— {"id": "O", "jsonrpc": "2.0", "result": "Running"}

4.6.1 Examples

* Requesting DAQ State:

——=> {"id": "0", "Jjsonrpc": "2.0", "method": "getDAQState", "params": []}
<——— {"id": "0", "Jjsonrpc": "2.0", "result": "Running"}

Starting data acquisition:

——=> {"id": "0", "Jjsonrpc": "2.0", "method": "startDAQ", "params": []}
<——— {"id": "0", "Jjsonrpc": "2.0", "result": true}

An error response:

——=> {"id": "0", "jsonrpc": "2.0", "method": "startDAQ", "params": []}
<-—— {"error": {"code": 102, "message": "DAQ readout worker busy"}, "id": "0",
—"Jsonrpc": "2.0"}

* Requesting DAQ stats:

——=> {"id": "0", "Jjsonrpc": "2.0", "method": "getDAQStats", "params": []}

<——— {"id": "O", "jsonrpc": "2.0", "result": {"analysisEfficiency": 1,
—"analyzedBuffers": 4644, "buffersWithErrors": 0, "currentTime": "2018-06-
—~14T11:45:21", "droppedBuffers": 0, "endTime": null, "listFileBytesWritten":
-0, "listFileFilename": "", "runId": "180614_114412", "startTime": "2018-06-—
—14T11:44:13", "state": "Running", "totalBuffersRead": 4644, "totalBytesRead
—": 6366924, "totalNetBytesRead": 5851300} }

4.6.2 Methods

4.6.2.1 getVersion

Returns the version of MVME running the JSON RPC services.
* Parameters
None
* Returns

String containing version information.
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4.6.2.2 getLogMessages

Returns the messages buffered up in the MVME log.
* Parameters
None
e Returns

StringList - List containing the log messages from oldest to newest.

4.6.2.3 getDAQStats
Returns information about the current DAQ run including counter values, the current run ID, listfile output file-
name and start time.
* Parameters
None
e Returns

Object

4.6.2.4 getVMEControllerType

Returns the type of VME controller in use.
e Parameters
None
* Returns

String

4.6.2.5 getVMEControllerStats

Returns detailed VME controller statistics if available for the current controller type.
* Parameters
None
* Returns:

Object

4.6.2.6 getVMEControllerState

Returns the connection state of the VME controller.
* Parameters
None
* Returns:

String - “Connected”, “Disconnected” or “Connecting”
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4.6.2.7 reconnectVMEController

Starts a reconnection attempt of the VME controller. The operation is asynchronous, thus the result will not be
directly available. Instead the controller state needs to be polled via getVMEControllerState to see the
result of the reconnection attempt.

Note: this might in the future be changed to a synchronous version, which immediately returns the result or any
errors that occured.

¢ Parameters
None
¢ Returns:

String - “Reconnection attempt initiated”

4.6.2.8 getDAQState

Returns the current state of the DAQ.
* Parameters
None

CEINTS LEINT3

¢ Returns String - “Idle”, “Starting”, “Running”, “Stopping” or “Paused”

4.6.2.9 startDAQ

Starts a new DAQ run. The system must be idle, meaning any previous DAQ runs must have been stopped.
* Parameters
None
* Returns

true on success, error status and additional information otherwise.

4.6.2.10 stopDAQ

Stops the current DAQ run.
* Parameters
None
* Returns

true on success, error status and additional information otherwise.
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CHAPTER
FIVE

HOW-TO GUIDES

5.1 Rate Estimation Setup

This example shows how to use the rate estimation feature built into 1D histograms. Rate estimation works with
statistical data that forms an exponential function.

In this example and MDPP-16_SCP is used but any mesytec VME module should work. The rate estimation is
setup for channel 8 of the MDPP.

To make use of the rate estimation feature a 1D histogram accumulating the difference between timestamp values
of incoming events needs to be created.

Note: For the module to produce timestamps instead of event counter values the register 0x 6038 needs to be set
to 1. mvme does this by default for newly created modules in the VME Interface Settings script.

Steps for creating the histogram:

5.1.1 Timestamp extraction

Add a new Extraction Filter with two filter words to the mdpp16:

0001 XXXX XX00 1000 XXXX XXXX XXXX XXXX any
11XX XXXX XXXX XDDD DDDD DDDD DDDD DDDD any

The first filter word matches on the data word for channel 8: the prefix 0001 identifies a data word, the pattern
00 1000 is used to select channel 8 specifically.

The second filter word is used to extract the timestamp value. The prefix 11 marks an End of Event word which
contains the 30-bit timestamp. Using the D character 19-bits of the timestamp value are extracted.

Set the name of the filter to zs_c8 and click Ok to create the filter.

The complete filter will thus match if there was a data word for channel 8 and the event contained a timestamp
data word.

5.1.2 Timestamp calibration

By default the timestamp is generated using the 16 MHz VME SYSCLK. This means the 19-bit timestamp value
is in units of 16 MHz.

The goal is to convert the value to us which is easier to use: 219/16 = 219 /2% = 215 = 32768.

Thus instead of ranging from [0, 2'°[ the timestamp should use the range [0, 2.

To transform the value create a Calibration Operator by right-clicking inside the LI Processing tree (or any higher
level processing tree) and selecting New -> Calibration. Use the green + button in the top-right corner to add a
new user level if necessary.
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As input select the #s_c8 node created in the previous step. Keep the default name ts_c8.cal. Type ps in the Unit
Label field, set Unit Max to 32768 and press the Apply button. Accept the dialog by pressing Ok.

@ Level Visiblity |:||¢|

Event: event0 - |

il

LO Parameter Extraction L1 Processing
¥ e Mdpplts

New Calibration 4+ 0O

| ts cB | | o |

LO Raw Data Display Mame [ts_c8.cal |
= Mdppl6 Unit Label ps |
Unit Min | 0.00000000 -
Unit Max | 32768.00000000 -
+ Apply K
Address Min Max
0 o 32768

Fig. 5.1: Timestamp calibration

5.1.3 Making the previous timestamp available

Next right-click in the L1 Processing tree (or any higher level processing tree) and select New -> Previous Value.

As input select the ts_c8.cal node created in the previous step. Make sure the Keep valid parameters box is
checked. Set the name to ts_c8.cal.prev.

65/75
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Event: event0 = | @ Level Visiblity = ||
LO Parameter Extraction L1 Processing =
* [ mdppl6 b L. Calts cB.cal
» 7 ts_c8B .
i\ New Previous Value 4+ 0O X
Input
LE’ <select= ] (%)
Mame
LO Raw Data Display v| Keep valid parameters
= mdpplf&

If Keep valid parameters is checked the previous
valid input values will be copied to the cutput.

Otherwise the input from the previous event will
be copied, including invalids.

Cancel

Fig. 5.2: Adding the PreviousValue operator

5.1.4 Histogramming the timestamp difference

Again right-click in one of the processing trees and choose New -> Difference. Set input A to ts_c8.cal and input
B to ts_c8.cal.prev. Set the name to ts_c8.diff.
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Event: eventd = M > Level Visiblity = |¢|
LO Parameter Extraction L1 Processing =
* e mdppl6 b . Calts c8.cal

b T ts cB » ") Prevts c8.cal.prev
![E New Difference + 0O X
Inputs
A | ts_c8.cal =]

B L$ ts_c8.cal.prev | Kx2

LO Raw Data Display
e Mdpp16 Name |ts_c8,diff |

| oKk || Cancel |

Fig. 5.3: Calculating the timestamp difference

Right-click in the display tree below and add a new 1D histogram using the difference zs_c8.diff as the input.

Open the newly created histogram click on Subrange, select Limit X-Axis and enter (0.0, 200.0) asthe limits.
This step limits the large default parameter range calculated by the Difference operator.
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¥-Scale Lﬁ Lﬂj *-“" E H :: ﬁ ﬁ Histogram #

Lin * | Gauss Rate Est. Clear Export Sawve Subrange Resolution Infa |0

35000 —

RM5 40,1848

BDDDD—: FWHM 29,2369
: Mean 465267
25000 — Max 4,73633
] Max¥ 29267
0 ] L T ~ "
= EDDDD—: W set histogram range *+ O X
g .
S 15000 & Limit X-Axis
1DDDD—: Min | 0.00 -
- Max | 200.00 =
5000 —
: Full Range
0 50 -

ts cB.diff [pus]

Fig. 5.4: Setting the histogram subrange

Next click the Rate Estimation button in the toolbar and then select two points on the x-axis to use for the rate
estimation.
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Histogram ts c8_diff

¥-Scale Lﬁ I_ﬂ ‘H-" E H :: ﬁ ﬁ Histagram #

Lin * | Gauss  Rate Est. = Clear Expert Save Subrange Resolution Infa | O

30000 —:\ freeRate=0.02343 Y. eff=0.8713 [RMS  40.1443
I\ | FWHM 29,2406
i : : Mean 46 4679
25000 7 | \ g Max  4.73633
| . ; Max¥ 28539
E 20000 - : : Counts 1.25616e+07
C ] E E
g ] i i
S 15000 | E
10000 | & i i
- ] |
o LI Ul !
112 E
5000 o {7 i
dl | !
q = i
o dU E
I T T T T I T T T T I T T T T I T T T T I
0 50 100 150 200

ts cB.diff [ps]

Fig. 5.5: Rate estimation data and curve visible

The calculation performed is:

7 = (v2 — x1)/log(y1/y2)
Y=y * (e—m/f/e—mﬁ-)
freeRate = 1.0/7

5.2 VM-USB Firmware Update

The VM-USB firmware update functionality can be found in the mvme main window under Tools -> VM-USB
Firmware Update. The latest firmware file is included in the mvme installation directory under extras/vm-usb.

Before starting the update set the Prog dial on the VM-USB to one of the programming positions P1-P4.

The controller will start the newly written firmware immediately after writing completes. Reset the Prog dial to
C1-C4 to make the controller start the correct firmware on the next power cycle.
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CHAPTER
SIX

6.1

CHANGELOG

Version 1.0.0-rc (wip)

Add ability to run the data acquisition for a limited amount of time before automatically stopping the run.
Add VME templates for the MDPP-32 (SCP and QDC variants).

[vme_script] Drop support for the ‘counted block read‘ commands. They are complex, rarely used and the
MVLC does not currently support them. As long as a VME module supports either reading until BERR or
can be read out using a fixed amount of (M)BLT cycles there is no need for these special commands.

[vme_script] VME scripts now support floating point values, variables and embedded mathematical expres-
sions.

[vme_config] Updates to the mesytec module templates and the internal config logic to make use of the new
VME script variables.

These changes make IRQ and MCST handling with multiple modules and events much simpler. When using
only mesytec modules no manual editing of scripts is required anymore.

When loading a config file from a previous mvme version all module and event scripts will be updated to
make use of the standard set of variables added to each VME event.

Improve Ul responsiveness with the MVLC at low data rates.
Multiple MVLC fixes and improvements.
Various bugfixes and UI improvements
— VME Script error messages are now highlighted in red in the log view.

— Speed up creating and updating the analysis tree views. This is especially noticeable when using many
modules or many VME events.

Upgrade Qt to version 5.14.1 on the build servers.

Do not ship libstdc++ with the linux binary package anymore. It caused issues in combination with setting
LD_LIBRARY_PATH as is done in the initMVME shell script.

Version 0.9.6

Improved support for the MVLC. Among others VME Scripts can now be directly executed during a DAQ
run without having to pause and resume the DAQ.

New UI for setting up the MVLC Trigger and I/O logic system.

Updates to the auto-matching of vme and analysis objects on config load.
Improved the mvlc_root_client

Documentation updates

Improved VME module templates
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* Various stability and bugfixes

6.3 Version 0.9.5.5

This is the first version with support for the upcoming mesytec MVLC VME controller.

Added the EventServer component which allows to transmit extracted readout data over a TCP connection.

Added a client for the EventServer protocol which generates and loads ROOT classes, fills instances of the
generated classes with incoming readout data and writes these objects out to a ROOT file. Additionally user
defined callbacks are invoked to perform further analysis on the data.

6.4 Version 0.9.5.4

* Log values written to the VMUSB ActionRegister when starting / stopping the DAQ

6.5 Version 0.9.5.3

e Allow access to all VMUSB registers via vme_script commands vmusb_write_reg and
vmusb_read_reg

* Fix a crash in HistolDWidget when resolution reduction factor was set to 0

6.6 Version 0.9.5.2

* Fix arace condition at DAQ/replay startup time

* Remove old config autosave files after successfully loading a different config. This fixes an issue where
apparently wrong autosave contents where restored.

* Rewrite the analysis session system to not depend on HDFS anymore. This was done to avoid potential
issues related to HDF5 and multithreading.

Note: Session files created by previous versions cannot be loaded anymore. They have to be recreated by
replaying from the original readout data.

6.7 Version 0.9.5.1

This release fixes issues with the code generated by the analysis export operator.

Specifically the generated CMakeLists.txt file was not able to find the ROOT package under Ubuntu-14.04 using
the recommended way (probably other versions and other debian-based distributions where affected aswell). A
workaround has been implemented.

Also c++11 support is now properly enabled when using CMake versions older than 3.0.0.
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6.8

Version 0.9.5

Note:

Analysis files created by this version can not be opened by prior versions because the file format has

changed.

This version contains major enhancements to the analysis user interface and handling of analysis objects.

It is now possible to export an object selection to a library file and import objects from library files.

Directory objects have been added which, in addition to the previously existing userlevels, allow to further
structure an analysis.

Directories can contain operators, data sinks (histograms, rate monitors, etc.) and other directories.
Objects can now be moved between userlevels and directories using drag and drop.
A copy/paste mechanism has been implemented which allows creating a copy of a selection of objects.

If internally connected objects are copied and then pasted the connections will be restored on the copies.

Other fixes and changes:

6.9

New feature: dynamic resolution reduction for 1D and 2D histograms.

Axis display resolutions can now be adjusted via sliders in the user interface without having to change the
physical resolution of the underlying histogram.

Improved hostname lookups for the SIS3153 VME controller under Windows. The result is now up-to-date
without requiring a restart of mvme.

Add libpng to the linux binary package. This fixes a shared library version conflict under Ubuntu 18.04.

SIS3153: OUT2 is now active during execution of the main readout stack. Unchanged: OUT!I is active
while in autonomous DAQ mode.

The Rate Monitor can now take multiple inputs, each of which can be an array or a single parameter.
Also implemented a combined view showing all rates of a Rate Monitor in a single plot.

Add new VM-USB specific vme script commands: vmusb_write_reqg and vmusb_read_reg which
allow setting up the VM-USB NIM outputs, the internal scalers and delay and gate generators.

Refer to the VM-USB manual for details about these registers.

Version 0.9.4.1

Fix expression operator GUI not properly loading indexed parameter connections

Split Histo1D info box into global and gauss specific statistics. Fixes to gauss related calculations.

6.10 Version 0.9.4

New: Analysis Expression Operator

This is an operator that allows user-defined scripts to be executed for each readout event. Internally exprtk
is used to compile and evaluate expressions.

New: Analysis Export Sink

Allows exporting of analysis parameter arrays to binary files. Full and sparse data export formats and
optional zlib compression are available.
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Source code showing how to read and process the exported data and generate ROOT histograms can be
generated.

» New: Analysis Rate Monitor

Allows to monitor and plot analysis data flow rates and rates calculated from successive counter values (e.g.
timestamp differences).

* Moved the MultiEvent Processing option and the MultiEvent Module Header Filters from the VME side to
the analysis side. This is more logical and allows changing the option when doing a replay.

* General fixes and improvements to the SIS3153 readout code.
¢ New: JSON-RPC interface using TCP as the transport mechanism.

Allows to start/stop DAQ runs and to request status information.

6.11 Version 0.9.3

* Support for the Struck SIS3153 VME Controller using an ethernet connection
* Analysis:
— Performance improvments

Better statistics

Can now single step through events to ease debugging

Add additional analysis aggregate operations: min, max, mean, sigma in x and y

Save/load of complete analysis sessions: Histogram contents are saved to disk and can be loaded at a
later time. No new replay of the data is neccessary.

New: rate monitoring using rates generated from readout data or flow rates through the analysis.
* Improved mesytec vme module templates. Also added templates for the new VMMR module.
* More options on how the output listfile names are generated.

* Various bugfixes and improvements

6.12 Version 0.9.2

* New experimental feature: multi event readout support to achieve higher data rates.

 DataFilter (Extractor) behaviour change: Extraction masks do not need to be consecutive anymore. Instead
a “bit gather” step is performed to group the extracted bits together and the end of the filter step.

» UI: Keep/Clear histo data on new run is now settable via radio buttons.

* VMUSB: Activate output NIM O2 while DAQ mode is active. Use the top yellow LED to signal “USB
InFIFO Full”.

* Analysis performance improvements.

* Major updates to the VME templates for mesytec modules.

6.13 Version 0.9.1

* Record a timetick every second. Timeticks are stored as sections in the listfile and are passed to the analyis
during DAQ and replay.

* Add option to keep histo data across runs/replays
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* Fixes to histograms with axis unit values >= 231

* Always use ZIP format for listfiles
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